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ABOUT THIS MANUAL 
READ THIS OPERATING MANUAL BEFORE ATTEMPTING TO USE THE INSTRUMENT. 

 

This manual is valid for the CA850/4A (from firmware 1.7.0.0 onwards).  

This product is manufactured by:  
 Amplivox Ltd 

 
Geneva House 

  
Starley Way  

Birmingham B37 7GN 
www.amplivox.com 

For all enquiries please contact us under: 
 

Amplivox Ltd 
Geneva House  

Starley Way  
Birmingham B37 7GN 

United Kingdom  
Tel: +44 (0)1865 880846 

 
hello@amplivox.com 

 

 

http://www.amplivox.com/
mailto:hello@amplivox.com
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1. INTRODUCTION 

1.1. THANK YOU 

Thank you for purchasing the Amplivox CA850/4A audiometer, an air-conduction screening audiometer that is designed 

for use by the army offering both H-categorisation (Pulheems) and HSE categorisation. Its primary use is as an automatic 

audiometer (interfacing to and launched from the Amplivox CA850/4A Database or Amplisuite). However it may also be 

used as a “standalone” manual audiometer that can save the results of up to 12 tests.  

This operating manual applies to the CA850/4A in combination with CA850/4A Database or Amplisuite. 

 

1.2. INTENDED APPLICATIONS 

This solution is designed for use by trained personnel only, such as occupational health personal and hearing healthcare 

professionals with a similar level of education. It is not recommended to use the equipment without the necessary 

knowledge and training.  

 

1.3. CONTRAINDICATIONS 

Always visually inspect the outer ear and the external auditory canal for abnormalities before testing.  

Testing should not be performed on patients if the following conditions are applicable:  

1. The presence of other sensitivity to loud sounds when high intensity stimuli are used. 
2. Recent outer ear surgery. 

 

1.4. STANDARD AND OPTIONAL ACCESSORIES 

 

STANDARD ACCESSORIES 

CA850/4A Audiometer 8531648 Calibration certificate  

Audiometric headset, Audiocups,  
Earphones DD45 1 

8516560 Carrying case 8004674 

Mains adaptor 8512734 Cable USB – A & B connector 8011241 

Patient response switch 1 8011155   

    
 

OTHER COMPONENTS TO REORDER 

Audiocups (noise reducing earphone enclosures) 8010855 Headset lead 8010822 

Audiocup ear cushion 8010835 Earphone cushion 8010857 

Audiocup headband 8507920 Earphones DD45 * 8010876 

Audiocup headband cover 8010834 Booth leads 8510195 

 
1 Applied part according to IEC60601-1 
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Accessories marked * require calibration with the specific audiometer to be used. Do not attempt to use these 

accessories until the audiometer has been calibrated to match their characteristics. 

 

1.5. GUARANTEE 

All Amplivox instruments are guaranteed against faulty materials and manufacture. The instrument will be repaired free 

of charge for a period of two years from the date of dispatch if returned, carriage paid, to the Amplivox service 

department. Return carriage is free of charge for customers in the UK and chargeable for overseas customers. 

 

1.6. WARNINGS 

Throughout this manual, the following meanings of warnings and cautions apply: 

 

The WARNING label identifies conditions or practices that may present danger to the 

patient and/or user.  

 

The CAUTION label identifies conditions or practices that could result in damage to the 

equipment. 

 

  

WARNING 

CAUTION 
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2. PRINCIPLES OF OPERATION 

2.1. OTOSCOPIC EXAMINATION 

A suitably-qualified health care professional should perform a thorough otoscopic examination to establish that the 

condition of the ear is suitable for the test options selected and that no contraindications are present. The latter would 

include obstruction of the external ear canal due to excessive wax and/or hairs, both of which would need to be 

removed. This is required to ensure that the probe tone delivered by the probe are able to reach the ear drum and are 

not reflected by cerumen or debris and thereby alter the test result. 

 

2.2. PRINCIPALS OF PURE TONE AUDIOMETRY 

Ideally, hearing tests are conducted in a soundproof room. The purpose of pure tone audiometry is to measure the 

patient’s hearing threshold which is then compared to the hearing threshold of an average normal hearing person. The 

examination starts with air conduction on the ear with better hearing, or if not specified differently, on the right ear. 

The BSA (British Society of Audiology) recommends starting the test at 1000 Hz to then next measure the higher 

frequencies. When done with the high frequencies 1000 Hz shall be retested and to then continue with the lower 

frequencies.  

 

2.3. AUDIOMETRY PREPARATION 

Refer to the various audiometric standards and other relevant publications for guidance on audiometric testing. 

 

Ambient Conditions 

Audiometric testing should always be performed in quiet conditions (e.g. a quiet room or an acoustic booth). The 

Amplivox Audiocups provide an additional level of isolation from ambient noise.  For further explanation on permissible 

ambient noise levels, please refer to the audiometry standard ISO 6189. 

 

Test System Arrangement 

The schematic diagram below shows a typical example of the use of audiometric test equipment. The audiometer is 

located on the desk of a seated operator as shown. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

The patient is seated in front of the desk facing away from the operator. The patient wears a headset (see below) and 

responds to test stimuli by use of a hand-held switch which is also connected to the instrument. 

Operator 

 

CA850/4A 

Audiometer 

 

Computer (e.g. Tablet/Laptop) 

Patient, wearing headset 

 
Headset lead 

 

Response switch & lead 
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Headset 

The headset must be fitted by a qualified person to ensure a proper seal and comfortable fit. The leads from the headset 

are connected to the instrument and the headset is then fitted to the patient. 

 

Patient Instructions 

The patient is given the following instructions: “Press and then release the response switch when a tone is heard”. 

• In the case of Manual or Computer testing – “As soon as you hear the tone, press and release the response 

switch” 

• In the case of Bekesy testing – “press and hold the response switch when a series of pulses are heard, and 

release when the pulses are no longer heard” 
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3. UNPACKING AND INSTALLATION 

3.1. GENERAL 

Please check the contents of the shipping carton to make sure that all items ordered have been included. If anything is 

missing, please contact the distributor who supplied the audiometer or Amplivox if purchased directly. 

Please retain the carton and packaging as the instrument will need calibrating on an annual basis and should be returned 

to Amplivox in its original shipping carton. 

 

3.2. MARKINGS 

The following markings can be found: 

Symbol Explanation 

 

Type B applied parts. According to IEC 60601-1. 

Patient applied parts that are not conductive and can be immediately released from the patient. 

 

Refer to instruction manual. 

 

WEEE (EU-directive) 

This symbol indicates that when the end-user wishes to discard this product, it must be sent to 

separate collection facilities for recovery and recycling. Failing to do so may endanger the 

environment. 

 

The CE-mark indicates that Amplivox Ltd. meets the requirements of Annex II of the Medical 

Device Directive 93/42/EEC. TÜV Product Service, Identification No. 0123, has approved the 

quality system. 

 

Serial number. 

 

Date of manufacture. 

 

Manufacturer. 

 

Keep dry. 

 

Transport and storage humidity range. 

 

Transport and storage temperature range. 
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Medical Device. 

 

Logo. 

 

Identifies the control by means of which the instrument is switched on from (or returned to) a 

standby condition. A long press to enter standby. A short press to wake the device from standby. 

 

3.3. SAFETY INSTRUCTIONS 

3.3.1. GENERAL 

The following safety precautions must be observed at all times. General safety precautions must be followed when 

operating electrical equipment. Failure to observe these precautions could result in damage to the equipment and injury 

to the operator or patient.  

The employer should instruct each employee in the recognition and avoidance of unsafe conditions and the regulations 

applicable to his or her work environment to control or eliminate any hazards or other exposure to illness or injury.  

Amplivox Ltd. is aware that safety rules within individual organizations vary. If a conflict exists between the instructions 

in this manual and the rules of the organization using this instrument, the more stringent rules should take precedence.  

The CA850/4A is intended to be used by hearing healthcare professionals (i.e. ENT doctors, audiologists), nurses or 

technicians who have been trained in the proper use of the device. 

 

3.3.2. CAUTIONS – GENERAL 

 

If the system is not functioning properly, do not operate it until all necessary repairs are made and the unit is tested and 

calibrated for proper functioning in accordance with Amplivox’s specifications. 

Do not drop or in any other way cause undue impact to this device. If the instrument is damaged, return it to the 

manufacturer for repair and/or calibration. Do not use the instrument if any damage is suspected. 

This product and its components will perform reliably only when operated and maintained in accordance with the 

instructions contained in this manual, accompanying labels, and/or inserts. A defective product should not be used. 

Make sure all connections to external accessories are secured properly. Parts which may be broken or missing or are 

visibly worn, distorted, or contaminated should be replaced immediately with clean, genuine replacement parts 

manufactured by or available from Amplivox Ltd. 

Equipment is not user repairable. Repairs must be performed by an authorised service representative only. No 

modifications of the equipment are allowed by anyone other than a qualified Amplivox Ltd. representative. Modification 

of the equipment could be hazardous. 

CAUTION 



   
 UNPACKING AND INSTALLATION 

 
 

 

14   CA850/4A INSTRUCTION FOR USE                                                                                                                   D-0131946-C
  

 

Amplivox Ltd. will make available on request component part lists, descriptions, calibrations instructions, or other 

information that will assist authorised service personnel to repair those parts of this instrument that are designated by 

Amplivox Ltd. as repairable by service personnel.  

No parts of the equipment can be serviced or maintained while in use with the patient. 

Connect only accessories purchased from Amplivox Ltd. to the CA850/4A. Only accessories which have been stated by 

Amplivox Ltd. to be compatible are allowed to be connected to the device. 

To comply with the standards IEC 60601-1 for safety and IEC 60601-1-2 for electromagnetic compatibility (EMC) the 

audiometer is designed to be used only with the medically-approved mains adapter supplied, which is specified as part 

of the equipment. Do not use any other type of mains adapter with this instrument. 

The output from the mains adapter is fitted with electronic circuit protection. In case of overload the adapter will shut 

down. When the fault is cleared the adapter will operate as normal.  

The input to the mains adapter is protected with a non-replaceable fuse. If this fails the adapter will not operate. 

The mains adapter is the mains disconnect device and therefore the audiometer should be positioned such that easy 

access to the mains adapter is possible. 

 

3.3.3. ENVIRONMENTAL FACTORS 

 

 

Use and store the instrument indoors only. It is recommended that the instrument be 

operated within an ambient temperature range of 15 °C / 59 °F to 35 °C / 95 °F and in 

relative humidity between 30 % and 90 % (non-condensing). 

Do not use the device in the presence of fluid that can come into contact with any of the electronic components or 

wiring. Should the user suspect fluids have contacted the system components or accessories, the unit should not be 

used until deemed safe by an authorized service technician. 

 

3.3.4. ELECTRICAL AND ELECTROSTATIC SAFETY 

 

Before performing any service to the earphones you must uncouple the transducers 

from the patient. 

 

 

Do not touch the contacts on the back of the instrument and the patient at the same 

time. The consequence could be a too high leakage current to the patient. 

Do not open the case of the instrument. Refer servicing to qualified personnel. 

This equipment is intended to be connected to other equipment thus forming a Medical Electrical System. External 

equipment intended for connection to signal input, signal output or other connectors must comply with the relevant 

product standard e.g. IEC 60950-1 for IT equipment and the IEC 60601-series for medical electrical equipment. In 

addition, all such combinations – Medical Electrical Systems – must comply with the safety requirements stated in the 

general standard IEC 60601-1, (edition 3.1), clause 16. Any equipment not complying with the leakage current 

requirements in IEC 60601-1 must be kept outside the patient environment i.e. at least 1.5m from the patient support 

CAUTION 

WARNING 

CAUTION 
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or must be supplied via a separation transformer to reduce the leakage currents. Any person who connects external 

equipment to signal input, signal output or other connectors has formed a Medical Electrical System and is therefore 

responsible for the system to comply with these requirements. If in doubt, contact a qualified medical technician or 

your local representative. When the instrument is connected to a PC, or other similar items, beware of not touching the 

PC and patient simultaneously. 

A Separation Device (isolation device) is needed to isolate the equipment located outside the patient environment from 

the equipment located inside the patient environment. In particular such a Separation Device is required when a 

network connection is made. The requirement for the Separation Device is defined in IEC 60601-1 clause 16. 

Do not use any additional multiple socket-outlet or extension cord. Use only UES12LCP Power Supply. 

 

3.3.5. ELECTROMAGNETIC COMPATIBILITY (EMC) 

 

Although the instrument fulfils the relevant EMC requirements, precautions should be 

taken to avoid unnecessary exposure to electromagnetic fields, e.g., from mobile 

phones, etc. If the device is used adjacent to other equipment it must be observed that 

no mutual disturbance appears. Please also refer to the EMC section in this manual. 

 

3.3.6. EXPLOSION HAZARDS  

 

Risk of explosion.  

Do not use in the presence of flammable anesthetics or other gases. 

Do NOT use in the presence of flammable gaseous mixtures. Users should consider the 

possibility of explosions or fire when using this device in close proximity to flammable 

anesthetic gases.  

Do NOT use the CA850/4A in a highly oxygen-enriched environment, such as a 

hyperbaric chamber, oxygen tent, etc. 

 

3.3.7. MEASURING SECURITY 

To guarantee that the CA850/4A works properly, the instrument should be checked and calibrated at least once a year. 

The transducers supplied with the audiometer are specifically calibrated with it; if these transducers are changed 

recalibration will be required. 

The service and calibration must be performed by an authorised service technician. If these checks are not performed, 

EU Medical Device Regulation (MDR) and other regulations may be violated and warranties may be void. 

The use of non-calibrated devices can lead to incorrect test results and is not advisable.  

 

3.3.8. MISCELLANEOUS 

Please note: DO NOT connect the CA850/4A hardware to the computer before the software has been installed. 

Storage in temperatures below 0C /32F and above 50C /122F may cause permanent damage to the instrument and 

its accessories. 

CAUTION 

WARNING 
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Do not place the instrument next to a heat source of any kind. 

Great care should be exercised when handling transducers, as rough handling, for example dropping onto a hard surface 

may break or damage the parts. 

 

Within the European Union it is illegal to dispose of electrical and electronic waste as unsorted 
municipal waste. Electrical and electronic waste may contain hazardous substances and therefore have 
to be disposed of separately. Such products will be marked with the crossed-out wheelie-bin image 
shown to the left. User cooperation is important in order to ensure a high level of reuse and recycling 
of electrical and electronic waste. Failure to recycle such waste products in an appropriate way may 
endanger the environment and consequently the health of human beings. 

Outside the European Union, local regulations should be followed when disposing of the product after its end of life. 

 

3.3.9. USE AFTER TRANSPORT AND STORAGE 

Please make sure that the instrument is functioning correctly before use. If the instrument has been stored in a cold 

environment (even for short period of time), please allow the instrument to become acclimatized. This can take long 

time depending on the conditions (such as environmental humidity). You can reduce the condensation by storing the 

instrument in its original packaging. If the instrument is stored under warmer conditions than the actual use conditions 

no special precaution is required before use. Always ensure proper operation of the instrument by following routine 

check procedures for audiometric equipment. 

 

3.4. CONNECTIONS  

The accessory terminals and connections are labelled to ensure correct identification and connection as follows: 

 

1 Right (Red) 6.3 mm jack Air Conduction Headset (Right Ear) 

2 Left (Blue) 6.3 mm jack Air Conduction Headset (Left Ear) 

3 (not enabled)   

4 (not enabled)     

5 (not enabled)   

6 USB USB connector Computer (via USB port) 

  1                2                3               4                   5                   6                         7           8            9           10        
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7 (not enabled)   

8 Power 2.5 mm DC jack Mains AC/DC Adapter 

9 Response (Black) 6.3 mm jack Patient Response Switch 

10 On/Off switch  Push and hold to switch on or off 

 Please note: Only connect the accessories supplied with the instrument or supplied by Amplivox or an Amplivox 

distributor. These parts have been tested for use with the Amplivox CA850/4A audiometer for compliance with the 

standards IEC 60601-1 and IEC 60601-1-2. The use of accessories other than those specified may compromise 

compliance with these standards.  
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4. USING THE CA850/4A  
 

4.1. GENERAL  

 Please note: Before the CA850/4A can be used as an automatic audiometer, the PC software must be installed and 

registered on the connected PC. Refer to the later sections of this operating manual for details of this operation. 

On start-up the display will show the following default setting: 

SIGNAL dBHL   FREQUENCY Hz 

 30dB                            1kHz 

 < >           < >       

 

This indicates that the audiometer is now ready to be used for automatic testing which is initiated by the PC software. 

 

4.2. SWITCHING THE AUDIOMETER ON AND OFF 

Press and briefly hold the switch marked  (located on the back panel). No warm-up time is required. The display will 

briefly show the model and the type of headphone currently in use. To switch off, press the switch marked  again, or 

press and hold the MENU key followed by the YES (RIGHT) key and then release both. 

 

4.3. USING THE TALKOVER FUNCTION 

If the TALKOVER key is pressed while an automatic test is in progress the test will be paused with a dialogue box 

displayed as below.  

 

After any necessary instruction is given to the patient and the TALKOVER key is released, the operator can choose to 

stop the test (“Abort”), retry the frequency that was being tested when the TALKOVER key was pressed (“Retry”), or 

skip the frequency that was being tested and move on to the next frequency (“Ignore”). 
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5. USING THE CA850/4A STAND-ALONE 

5.1. GENERAL  

Manual testing with the audiometer in “standalone” mode may be carried out without the connection to the PC.  

 

5.2. SWITCHING THE AUDIOMETER ON AND OFF 

Press and briefly hold the switch marked  (located on the back panel). No warm-up time is required. The display will 

briefly show the model and the type of headphone currently in use. To switch off, press the switch marked  again, or 

press and hold the MENU key followed by the YES (RIGHT) key and then release both. 

 

5.3. AUDIOMETER DISPLAY 

On start-up the display will show the following default setting:- 

SIGNAL dBHL   FREQUENCY Hz 

 30dB                            1kHz 

 < >           < >       

This indicates that when the PRESENT key is pressed, a tone will be presented at 30dBHL at a frequency of 1kHz to the 

indicated ear. On start up the audiometer defaults to the left ear. 

 

5.4. AUDIOMETER CONTROLS 

5.4.1. MULTIFUNCTION KEYS 

Several keys on the audiometer have different functions depending on the actual mode of operation. These are MENU 

(OFF), LEFT (NO), RIGHT (YES) and FREQUENCY   (MENU SELECT). The use of these keys is described below. 

5.4.2. MENU 

Press and hold MENU to access the following options. Use the MENU SELECT keys to step through the available options 

and then the NO, YES or SIGNAL  keys to select an action or modify a setting. Release of the MENU key then initiates 

the action or saves the modified setting and returns to the default display. 

Menu Option            Description 

Switch off?:            Press Power Button. 

Clear test?: Press YES and release MENU to clear the Threshold Retention 

Function results from the previous test 

Save audiogram to (1): Use the SIGNAL  keys to select the required storage location and 

press the YES key to save the audiogram; then release MENU 

Load audiogram no (1): Use the SIGNAL  keys to select the required storage location and 

press the YES key to load the audiogram; then release MENU 

Contrast:  Adjust contrast using the SIGNAL   keys; then release MENU 

External noise?:            Not Applicable. 
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Warble to Phones: Use the NO and YES keys to send frequency modulated tones to the 

headphones 

Default level:           Adjust the default tone presentation level using the SIGNAL  keys 

2.5dB step size:                  Always set to No 

 

5.4.3. DESCRIPTION OF FUNCTION OF OTHER KEYS 

PULSE    This enables the pulse tone present function when the PRESENT key is operated, the 

indicator above the key illuminates green 

RESET     Not Applicable 

MASK      Not Applicable 

RESULTS      Not Applicable 

+20dB      This enables tone levels to be presented with up to 20dB higher output in manual test 

mode; press the key and then use SIGNAL  to access the extra 20dB in 5dB steps; an 

indicator above the key illuminates green to show that the function is active 

BONE      Not Applicable 

AUTO      Not Applicable 

TALK OVER Hold this key to interrupt the test and route the operator’s voice from the front panel 

microphone to the headset; the level is adjusted with the SIGNAL  keys 

LEFT Press once to select the left ear (the indicator above the key illuminates green) 

RIGHT Press once to select the right ear (the indicator above the key illuminates green)  

SIGNAL Press the  keys to decrease or increase the level of the tone presented in 5dB steps; to 

scroll through the range keep the key pressed 

FREQUENCY Press the  key to select a lower frequency and the  key to select a higher frequency 

MASK ING     Not Applicable 

PRESENT Press to present the displayed test signal to the patient. The “PRESENT” indicator above 

the display will be illuminated green during tone presentation 

 

5.5. THRESHOLD RETENTION FUNCTION 

This function allows the thresholds determined for each ear and each frequency to be automatically stored and 

displayed for reference. 

The operator can then review the results at the end of the test and record them on an audiogram card or transfer them 

into the internal memory. 

Once the patient responds 2 in 3 times at a selected dB for a selected frequency, the threshold will automatically be 
stored and the level will be displayed in a similar way to that shown below. 
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To review the retained thresholds, use the FREQUENCY  keys to select the required frequency. The threshold values 

for the left and right ears are shown on the lower line of the display as illustrated below. 

SIGNAL dBHL          FREQUENCY Hz  

  30dB                         4kHz  

 20          10 

This display shows 

thresholds at 4kHz  

Thresholds retained Left ear 20dBHL 

Right ear 10dBHL 

To clear the Threshold Retention memory, press and hold the MENU key, use the FREQUENCY  keys to select “Clear 

test?  No”. Press YES and then release the MENU key. 

 

5.6. SAVING AUDIOGRAMS IN INTERNAL MEMORY 

The user may save up to 12 audiograms, referenced by number, in the internal memory of the audiometer. To save the 

current set of audiogram thresholds press and hold the MENU key, and then press MENU SELECT repeatedly until “Save 

Audiogram to 1” appears on screen. Use the SIGNAL  keys to select a location numbered 1-12, and then press the 

YES key. Release the MENU key once confirmation appears on the display. Note that the Save process will overwrite any 

records that exist in the selected memory location. 

 

5.7. LOADING AUDIOGRAMS FROM INTERNAL MEMORY 

Press and hold the MENU key, and then press MENU SELECT repeatedly until “Load Audiogram No 1” appears on screen. 

Use the SIGNAL  keys to select a location numbered 1-12, and then press the YES key. Release the MENU key once 

confirmation appears on the display. 

 

5.8. SUGGESTED SEQUENCE OF OPERATION AND TEST PROCEDURE 

The following notes are for guidance only. Refer also to ISO 8253 (Audiometric Test Methods) for further guidance. 

5.8.1. PRE-TEST 

(1) Switch the audiometer on 
(2) Perform a listening check 
(3) Decide whether to use the Threshold Retention Function and/or an audiogram card to record the thresholds 
(4) Prepare the test environment & patient 
(5) If the patient response switch is not being used give instructions to the patient to acknowledge any tone presented 

by raising or lowering the finger 
(6) If the patient response switch is in use give instructions to the patient to acknowledge any tone presented as 

follows: 
“As soon as you hear the tone, press the switch. When you no longer hear the tone, release the switch”. 

(7) Fit the headset to the patient. Select the better hearing ear (according to the patient) by pressing either the LEFT 
or RIGHT key and start the familiarisation session. 

5.8.2. FAMILIARISATION 

(1) Present the tone 30dB at 1kHz for between 1 and 2 seconds. If there is no response at 30dB, increase the 
attenuation level in 10dB steps until the patient responds 
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(2) When the patient responds, wait for 1 to 2 seconds and present the tone again at the same level; however, if the 
patient does respond at 30dB, reduce the signal level in 10dB steps, repeating the presentation until there is no 
response, then increase the signal level in 5dB steps until the patient responds, wait 1 to 2 seconds and present the 
tone again at the same level 

(3) If the responses are consistent with the pattern of tone presentation, start measuring the patient’s hearing 
thresholds; if not, repeat the familiarisation 

 

5.8.3. TEST 

(1) Use the Clear test option to clear any thresholds 
(2) Present the first test tone at 30dB at 1kHz 
(3) If the patient responds, reduce the signal level in 10dB steps repeating the presentation until there is no response; 

then increase the signal level in 5dB steps until the patient responds 
(4) If the patient does not respond, increase the signal level in 5dB steps until there is a response and then continue 

with step 5. 
(5) Repeat the test by reducing the signal level in 10dB steps until the patient no longer responds. Then increase the 

signal level in 5dB steps until a response occurs and note this level. 
(6) Repeat step 5 until the patient responds two out of a maximum of three times at the same signal level. This indicates 

the patient’s hearing threshold level for that frequency and is automatically stored. You could also mark the 
threshold on an audiogram card. 

(7) Proceed to the next test frequency. It is common practice to test the frequencies in the following order: 1k, 2k, 3k, 
4k, 6k, 8k and 500 Hz. 

(8) Repeat steps 2 to 7 for the other ear. 
 

5.8.4. POST-TEST 

(1) Use the Threshold Retention Function to review the results 
(2) If required do one or more of the following: 

• Record the results on an audiogram card, or 

• Save the results to the internal memory 
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6. USING THE CA850/4A COMPUTER CONTROLLED 

6.1. EQUIPMENT PREPARATION 

Connect the headset, patient response switch and power supply to the CA850/4A and then make the connection from 

the CA850/4A to the PC. No specific warm-up time is required although the device registration to the PC might take a 

short time to complete.  

 

6.2. STARTING THE SOFTWARE 

Start the CA850/4A Database or Amplisuite application, and with reference to the relevant sections of this user manual 

either establish a new patient, or access and display details of an existing patient. This section of the user manual will 

assume you are using the CA850/4A Database application. 

 

 

Use the left mouse button to click on the Launch Test icon on the CA850/4A Database toolbar. 

 

Alternatively use the “Test > Launch Test” drop-down menu selection at the top of the CA850/4A Database window. 

 

A new window will open for the PC controlled software. This software is called Otosure. If the patient has more than 

one set of audiometric results stored in CA850/4A Database the most recent audiogram is transferred and displayed in 

the Otosure window. 

 

The serial number and calibration date of the connected CA850/4A audiometer is shown at the bottom right of the 

Otosure window along with the test type currently selected. 

 

The test type last used is remembered; if this was a manual test the procedures may be followed; if this was an automatic 

test the following dialogue box will be displayed: 

 

 

To run the same automatic test using the same options (as last used) simply 
click the “Start test” button and the test will commence. 
 
If a manual test is required, or if the test options are to be modified, click the 
“Modify” button which will close the dialogue box. 

 

6.3. AVAILABLE TEST MODES 

6.3.1. MANUAL TESTING 

This allows the operator to use the CA850/4A to record hearing level thresholds using the computer’s keyboard and 

mouse. The resulting audiometric data may then be transferred to the CA850/4A Database application. 
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6.3.2. COMPUTER TESTING 

This is a method of automatic audiometry based on the Hughson and Westlake method and undertaken automatically 

by the instrument. The level is increased in 5dB steps until a response is obtained from the patient and decreased in 10 

dB steps until no response occurs. The process is repeated until, depending upon the criteria selected for recording a 

threshold, the instrument will record a threshold at that particular frequency. The CA850/4A then continues to the next 

test frequency and so on to complete the test on both ears. 

The CA850/4A provides the facility to run this test at specified single frequencies and add the results into the overall 

audiogram result. This feature is useful for situations where one particular frequency has proved problematic. 

 

6.3.3. BEKESY TESTING 

This is a method of automatic audiometry devised by Von Bekesy (1947) using pure tone stimuli to track auditory 
thresholds. 
 
This application is known as discrete frequency Bekesy testing and the principle behind the test is that the patient 
adjusts the presented level according to his hearing threshold. The decibel level decreases when the patient presses the 
response switch upon hearing the presented tone. Conversely when the patient can no longer hear the presented tone, 
he will release the response switch therefore allowing the level to increase until the presented tone is heard again. The 
level changes are in 2.5dB steps. 
 
When a number of these "peaks" and "valleys" have been consistently performed, the CA850/4A will calculate an 

average to the nearest dB and display this as the hearing threshold for that particular frequency. The CA850/4A then 

continues to the next test frequency and so on to complete the test on both ears. 

 

6.3.4. MIXED TESTING 

This is typically used when the automatic test has been unable to yield a threshold at one or more frequencies. It is 

possible to perform a manual test (normally at just a few selected frequencies) to complete an audiogram by adding 

thresholds to those already established. 

 

6.4. CONTROL BUTTONS  

  starts the selected automatic test  

 

  selects Bekesy (self-recording) test type 

 

  selects Computer test type 

 

  selects Manual test mode 

 

  selects test detail display 

 

  selects audiogram display 
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Presents a test tone in Manual test mode when the mouse pointer is moved over this icon; there is 
no need to click the mouse button. 
 

 
The icon changes to this format while a tone is being presented 
 

 Please note: The present icon will also be displayed during automatic testing, although use of 
the mouse as described above will have no effect when automatic testing is performed. 
 

 
Patient response indicator, displayed like this when the patient has not made a response. 
 

 
The icon changes to this format when a response is made. 
 

 

6.5. CONTROL – PC KEYBOARD AND MOUSE 

Keyboard, “L” key: selects left ear in Manual test mode 

Keyboard, “R” key: selects right ear in Manual test mode 

Keyboard,  key:  increases the sound level in Manual test mode 

Keyboard,  key:  decreases the sound level in Manual test mode 

Keyboard,  key: selects a lower tone frequency in Manual test mode 

Keyboard, → key: selects a higher tone frequency in Manual test mode 

Mouse, pointer:                  presents the test tone when positioned over the present icon in Manual test mode 

Mouse, left button: selects Windows-based options as normal 

Mouse, right button: in manual test mode only, plots a threshold 

 

6.6. MANUAL TESTING 

Click the Manual test button  (the button will then be highlighted) 

 

Alternatively use the “Test > Manual” drop-down menu selection at the top of the Otosure window. The following screen 

is displayed: 
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Note the cursor positioned in left ear audiogram area indicating the current frequency and dBHL value (also displayed 

at the bottom centre of the Otosure window). 

Moving the mouse over the “Present” icon  will present the prescribed tone at this level and frequency 

from the left earphone, and the “Present” icon will change to . 

 

If the patient presses the response switch the “Response” icon will change from a dark green colour  to 

a light green colour . 

 

To change the level of the presented tone, use the  and  arrow keys on the PC keyboard. 

 

When confident that a consistent response has been elicited at a particular level the threshold may be plotted on the 

screen by clicking the right mouse button. The numerical value of the threshold is added to the appropriate text box 

above the audiogram. If an error has been made, simply plotting a different threshold at the selected frequency will 

override any previous threshold. 

 

To clear all thresholds from the audiogram use the “Test > Clear readings …” drop-down menu selection and select the 

appropriate items to clear. 

 

To change the frequency of the presented tone, use the  and → arrow keys on the PC keyboard. Continue plotting 

thresholds until all desired frequencies have been tested. 

 

To select the right ear use the “R” key on the PC keyboard, and to return to the left ear use the “L” key. 
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Use the controls described above to build up a complete audiogram for the patient. Once satisfactorily completed, click 

on “Exit” at the top of the Otosure window and confirm to exit Otosure. The Otosure window will close and the 

CA850/4A Database window will display the test results. Refer to the CA850/4A Database section of this user manual 

for additional options, but it should be noted that the results must be saved in CA850/4A Database application to be 

retained in the database. 

 

6.7. COMPUTER TESTING 

Click the Computer test button (the button will then be highlighted) 

 
 

Alternatively use the “Test > Computer” drop-down menu selection at the top of the Otosure window. A screen is 

displayed but with the “Present” icon and cursor removed. 

 

To run a full Computer test on both ears simply click the “Run selected test” button. 

 
 

Alternatively use the “Test” drop-down menu option to select either a full test or a restricted test (for example, limited 

to a single ear). 

 

The Computer test will run according to the test options selected with the test status indicated at the bottom left of the 

Otosure window. The “Present” icon will re-appear and indicate when tones are presented, and the “Response” icon 

will change to light green when a patient response is made. 

 

To view the traces of the presented tones select the “Show test detail” button: 

 
Alternatively use the “View > Detail” drop-down menu option. 

 

To view the audiogram thresholds select the “Show Audiogram” button: 

 
Alternatively use the “View > Audiogram” drop-down menu option. 

 

The order of frequencies tested, assuming that all frequencies are selected, are 1kHz, 1.5kHz, 2kHz, 3kHz, 4kHz, 6kHz, 

8kHz, 750Hz, 500Hz, 250Hz and 125Hz. 

 

The time available for the patient to respond is from the point the tone is presented to the beginning of the next 

presented tone (approximately 2.3 seconds maximum). If a response is made within this time period a random delay is 

then added to the time until the next tone is presented. 

 

Once the test has been completed successfully the following dialogue box will be displayed: 
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If the test has not been completed successfully the following dialogue box will be displayed: 

 

 
 

To accept the results and transfer them to CA850/4A Database click on the “Accept” button. The Otosure window will 

close and the CA850/4A Database window will be displayed. Refer to the CA850/4A Database section of this user manual 

for additional options, but it should be noted that the results must be saved in CA850/4A Database application to be 

retained in the database. 

 

To continue testing click on the “Continue” option. The dialogue box will close and the operator may continue testing. 

 

6.8. BEKESY (SELF RECORDING) TESTING 

Click the Bekesy (self recording) test button (the button will then be highlighted) 

 
 

Alternatively use the “Test > Self recording” drop-down menu selection at the top of the Otosure window. A screen is 

displayed but with the “Present” icon and cursor removed. 

 

To run a full Bekesy (self recording) test on both ears simply click the “Run selected test” button. 

 
 

Alternatively use the “Test” drop-down menu option to select either a full test or a restricted test (for example, limited 

to a single ear). 

 

The Bekesy (self recording) test will run according to the test options selected with the test status indicated at the 

bottom left of the Otosure window. The “Present” icon will re-appear and indicate when tones are presented, and the 

“Response” icon will change to light green when a patient response is made. 

 

To view the traces of the presented tones select the “Show test detail” button: 

 
Alternatively use the “View > Detail” drop-down menu option. 

 

To view the audiogram thresholds select the “Show Audiogram” button: 

 
Alternatively use the “View > Audiogram” drop-down menu option. 

 

The order of frequencies tested, assuming that all frequencies are selected, are 125Hz, 250Hz, 500Hz, 750Hz.1kHz, 

1.5kHz, 2kHz, 3kHz, 4kHz, 6kHz, and 8kHz. 
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Once the test has been completed successfully the following dialogue box will be displayed: 

 

 
 

If the test has not been completed successfully the following dialogue box will be displayed: 

 

 
 

To accept the results and transfer them to CA850/4A Database click on the “Accept” button. The Otosure window will 

close and the CA850/4A Database window will be displayed. Refer to the CA850/4A Database section of this user manual 

for additional options, but it should be noted that the results must be saved in CA850/4A Database application to be 

retained in the database. 

 

To continue testing click on the “Continue” option. The dialogue box will close and the operator may continue testing. 

 

6.9. SINGLE-FREQUENCY TESTING 

In Computer test mode it is possible to run a test at a single frequency. For example, the operator might have noticed 

that the patient response at a particular frequency was erratic, or the automatic test was unable to establish a response 

at a particular frequency. 

 

The “Test > One freq. test” drop-down menu option may be used to select a single frequency for a particular ear. Clicking 

on the required option for frequency and ear initiates a test which will override any audiometric data already established 

for that frequency. At the end of the test the option to “Continue” or “Accept” is presented. 

 

6.10. MIXED-MODE TESTING 

This allows an audiogram to be completed by performing tests (typically at a few selected frequencies) using an 

alternative test type. For example, this facility could be used to perform a manual test if the automatic test option was 

unable to establish a threshold at a particular frequency. 

 

The legend “Mixed” is displayed at the bottom right of the Otosure window.  
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7. OPTIONS AVAILABLE TO SET-UP  

7.1. GENERAL 

The Otosure software stores the most recent test configuration and will initially use this to run any subsequent tests. 

However, there are a number of options available for setting up, modifying and controlling a test. These are summarised 

below - please refer to the operating window of the Otosure Software. 

 

7.2. MENU COMMANDS 

Exit: this closes the Otosure window and transfers any audiometric thresholds found plus other test detail to CA850/4A 

Database, if the user acknowledges the confirmation. 

 

Test: this provides access to a number of controls as follows: 

• Run full test (tests each ear in turn using the current automatic test type) 

• Left test (tests the left ear only using the current automatic test type) 

• Right test (tests the right ear only using the current automatic test type) 

• One freq. test (tests the selected ear & frequency combination using the current automatic test type) 

• Stop test (displays a further option to confirm or cancel the ‘Stop test’ command; the test continues until a 
response is made; if ‘Stop test’ is confirmed any thresholds found are retained) 

• Clear readings (clears all audiogram & threshold data, or only the data for the left or right ear) 

• Self recording (sets Bekesy (self recording) to be the current automatic test type) 

• Computer (sets Computer to be the current automatic test type) 

• Manual (sets the audiometer into the manual test mode) 
 

View: this allows either test “Detail” (graphical representation of presented tones and patient responses), or 

“Audiogram” (plots of thresholds found) to be selected 

 

Options: this opens a dialogue box, which provides access to the following options: 

• Frequencies – include or exclude 125Hz, 250Hz, 500Hz, 750Hz, 1.5kHz, 2kHz, 3kHz, 4kHz, 6kHz or 8kHz to/from 
the test regime 

• Computer test – controls to allow: 
o the selection of either 2 out of 3, or 3 out of 5 consistent responses to generate a valid threshold 
o Pulse – tone presentation is pulsed if selected 
o Omit repeat frequency – a retest of the 1kHz frequency omitted if selected (including this function can 

prove useful in correlating test results) 
o Omit repeat second ear – repeat on the second ear is omitted if selected 
o Pause on match fail – pause if the match fails 
o Start with familiarization – a familiarisation at 1kHz prior to the test 
o No Fam second ear – familiarisation skipped on the second ear if ticked 

• Tone response - controls to determine the action to be taken on error: 
o the number of times a frequency is repeated (0, 1, 2 or 3 times) if an error in testing occurs (for 

example, if there is an erratic response from the patient) 
o and then the action to be taken if the error continues (skip the frequency or pause the test) 

• Beep on finish – produces an audible tone to alert the operator that the test has finished 
 

Pause: immediately pauses the test and displays furthers options to abort the test, retry the current frequency being 

tested or ignore the current frequency and skip to the next one (skip not for a manual test); if the test is aborted any 

thresholds found are retained 
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About: displays the version of the Otosure software installed on the PC and the support email address 
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8. TROUBLESHOOTING 

8.1. GENERAL 

The CA850/4A audiometer is straightforward to use with an intuitive user interface, and if the instructions are followed 

the testing process should be performed easily. The product has been designed to detect and report a number of errors 

that could be encountered while performing audiometric testing and these are described below. 

 

8.2. NO INSTRUMENT FOUND 

If the audiometer has not been connected when a test is requested from CA850/4A Database, the Otosure software will 

not start and the following warning dialogue box will be displayed: 

 

 
 

Clicking OK will return to CA850/4A Database. 

 

Use the “Edit > Cancel Insert/Edit” option or cancel toolbar button to cancel the insert operation. The CA850/4A 

Audiometer may then be connected and CA850/4A Database operations continued. 

 

8.3. NO RESPONSE FROM PATIENT 

If the audiometer detects that no response to the test tone is made by the patient during an automatic test the tone 

level will increase to maximum and then the test will pause with the following message displayed on the PC screen: 

 

 
 

Depending on circumstances the operator may choose to abort the test, retry the frequency, or ignore the error (and 

proceed to testing of the next frequency). 

 

For a single frequency test, the tone level will also increase to maximum and then the test will pause with the following 

message displayed on the PC screen: 
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Depending on circumstances the operator may choose to retry the single frequency or cancel the single frequency test. 

 

Check that the patient fully understands the instructions previously given regarding use of the response switch. Check 

also that the response switch is connected and operating and that tones are being output from the headphones. 

 

8.4. RESPONSE SWITCH HELD ON 

If the audiometer detects that the response switch is not released by the patient during an automatic test the tone level 

will decrease to minimum and then the test will pause with the following message displayed on the PC screen: 

 

 
 

Depending on circumstances the operator may choose to abort the test, retry the frequency, or ignore the error (and 

proceed to testing of the next frequency). 

For a single frequency test, the tone level will decrease to minimum and then the test will pause with the following 

message displayed on the PC screen: 

 
 

Depending on circumstances the operator may choose to retry the single frequency or cancel the single frequency test. 

 

Check that the patient fully understands the instructions previously given regarding use of the response switch. Check 

also that the response switch is connected and operating and that tones are being output from the headphones. 
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8.5. ERRATIC PATIENT RESPONSE 

If the patient is not consistent in making responses during an automatic test it will not be possible for a threshold to be 

established. In these circumstances and depending on the test options selected the test may be paused or the next test 

frequency may be presented. If pause is selected, the test will pause with the following message displayed on the PC 

screen: 

 

)  
 

 Please note: This message will not be displayed for a single frequency test, but rather the test will complete but 

with errors (see below). 

 

If the audiometer manages to establish some but not all thresholds during an automatic test the following dialogue box 

will be displayed at the end of the testing process: 

 

 
 
This alerts the operator to the fact that errors in testing have occurred, and allows either: 

• further testing to be continued or 

• the thresholds that were established to be accepted and transferred to CA850/4A Database 
 

8.6. EXIT OTOSURE WITH NO RESULTS 

If the Otosure Software is closed without obtaining any test results the following warning will be displayed in CA850/4A 

Database: 

 

 
 

Click OK and then use the “Edit > Cancel Insert/Edit” option or cancel toolbar button to cancel the operation. 
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8.7. USB LEAD DISCONNECTED 

If the USB cable connecting the CA850/4A audiometer becomes disconnected any automatic test running will 

immediately cease, and the following message will be displayed: 

 

 
 

Once the message has been acknowledged, it will be possible to select control buttons and menu options in the Otosure 

window on the PC but these will have no effect. If the USB cable becomes disconnected, the recommended course of 

action is for the operator to close the Otosure window and return to CA850/4A Database. Then use the “Edit > Cancel 

Insert/Edit” option or cancel toolbar button to remove any data, and close CA850/4A Database. The CA850/4A may 

then be reconnected and CA850/4A Database started as usual. 

 

When the Otosure window is closed any thresholds found or plotted will be transferred into CA850/4A Database and 

care should therefore be taken with the use of this data. 
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9. ROUTINE MAINTENANCE 

9.1. GENERAL MAINTENANCE PROCEDURES 

The performance and safety of the instrument will be maintained if the following recommendations for care and 

maintenance are observed: 

1. It is recommended that the instrument go through at least one annual service, to ensure that the acoustical, 

electrical and mechanical properties are correct. This should be carried out by an authorized repairer in order 

to guarantee proper service and repair. 

2. Observe that no damage is present to the insulation of the mains cable or the connectors and that it is not 

exposed to any kind of mechanical load that could involve damage. 

3. To ensure that the reliability of the instrument is maintained, we recommend that the operator at short 

intervals, for instance once a day, performs a test on a person with known data. This person could be the 

operator.  

4. If the surface of the instrument or parts of it is contaminated, it can be cleaned using a soft cloth moistened 

with a mild solution of water and detergent or similar. Always disconnect the mains power adaptor during the 

cleaning process and be careful that no fluid enters the inside of the instrument or accessories. 

5. After each patient examination, ensure that there has been no contamination to the parts touching the patient. 

General precautions must be observed in order to avoid cross-contamination of disease from one patient to 

another. Water should be used for frequent cleaning, but in the case of severe contamination it may be 

necessary to use a disinfectant.  

 

• Before cleaning always switch off and disconnect from the power supply 

• Use a soft cloth lightly dampened with cleaning solution to clean all exposed surfaces 

• Do not allow liquid to come in contact with the metal parts inside the earphones/headphones 

• Do not autoclave, sterilize or immerse the instrument or accessory in any fluid 

• Do not use hard or pointed objects to clean any part of the instrument or accessory 

• Do not let parts that have been in contact with fluids dry before cleaning 

Recommended cleaning and disinfection solutions: 

• Warm water with mild, nonabrasive cleaning solution (soap) 

• 70% isopropyl alcohol only on hard cover surfaces 

 

9.2. AUDIOMETER MAINTENANCE 

The CA850/4A audiometer is a precision instrument. Handle it carefully in order to ensure its continued accuracy and 

service. When cleaning the instrument, use a soft damp cloth and mild detergent to clean the instrument panel. Refer 

to ISO 8253-1 for additional guidance. 

 

9.3. HEADSET MAINTENANCE 

Before use check the headset cables and connectors for signs of wear and/or damage. If you find any, please replace 

the item immediately by contacting Amplivox or your Amplivox distributor, requesting the relevant part number. 

CAUTION 
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Handle the audiometric headset (and audiocups) with care. For these parts that are in direct contact with the patient it 

is recommended that they are subjected to a standard disinfecting procedure between patients. 

 

This includes physically cleaning and use of a recognised disinfectant. The specific manufacturer's instructions should 

be followed for use of this disinfecting agent to provide an appropriate level of cleanliness. 

 

Clean the ear cushions (including those on the Audiocups, if used) with a recognised disinfectant, e.g. a “Mediswab”.  

 

 Please note: During the cleaning process do not allow moisture to enter the earphone. 

 

9.4. ACCESSORIES/REPLACEMENT PARTS 

Some reusable components are subject to wear with use over time. We recommend that you keep theses replacement 

parts available. 

 

9.5. REPAIR 

Amplivox Ltd.is only considered to be responsible for the validity of the CE marking, effects on safety, reliability and 

performance of the equipment if: 

• assembly operations, extensions, readjustments, modifications or repairs are carried out by authorized persons 

• a 1 year service interval is maintained  

• the electrical installation of the relevant room complies with the appropriate requirements, and 

• the equipment is used by authorized personnel in accordance with the documentation supplied by Amplivox 

Ltd. 

It is important that the customer (distributor) fills out the RETURN REPORT every time a problem arises and sends it to  

Amplivox Limited 

3800 Parkside, Solihull Parkway,  
Birmingham Business Park,  
Birmingham, West Midlands,  
B37 7YG  
United Kingdom  

hello@amplivox.com 

This should also be done every time an instrument is returned to Amplivox Ltd. (This of course also applies in the unlikely 

worst case scenario of death or serious injury to a patient or user). 

When packing the instrument for shipping, please use the original shipping carton and packing materials. Place the 

instrument parts in plastic bags before packing. 

 

9.6. WARRANTY 

Amplivox therefore gives the purchaser the following warranty. 
If within thirty-six months from the date of dispatch, any defect in respect of material or workmanship within our control 
is discovered, we will make good the defect without charge, subject to the following conditions; 
 

• Notice of the fault is given to Amplivox within the warranty period. 

https://demant.sharepoint.com/sites/bhx_connect/Marketing/MARKETING%20DEPARTMENT/LITERATURE/INSTRUCTION%20FOR%20USE/PC850/Manuals%20for%20next%20release/hello@amplivox.com
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• The instrument is forwarded, carriage paid, to Amplivox Limited at the above address or as otherwise 

directed. 

• The responsibility of Amplivox under this warranty is strictly limited to making good the defect in the 

instrument itself. 

• No attempt has been made to affect a repair or adjust the calibration or alter the instrument from the 

original build standard.  

• Defects caused by abnormal conditions of use, accident or neglect are expressly excluded. 

• The earphones may go out of calibration due to rough handling or impact (dropping). The life of the leads 

is also dependent upon conditions of use. These parts are only guaranteed against faulty materials or 

manufacture. 

 

If any product requires service during the applicable warranty period, the purchaser should communicate directly with 
the local Amplivox Ltd. service centre to determine the appropriate repair facility. Repair or replacement will be carried 
out at Amplivox’s expense, subject to the terms of this warranty. The product requiring service should be returned 
promptly, properly packed, and postage prepaid. Loss or damage in return shipment to Amplivox Ltd. shall be at 
purchaser's risk.  
 
In no event shall Amplivox Ltd. be liable for any incidental, indirect or consequential damages in connection with the 
purchase or use of any Amplivox Ltd. product.  
 
This shall apply solely to the original purchaser. This warranty shall not apply to any subsequent owner or holder of the 
product. Furthermore, this warranty shall not apply to, and Amplivox Ltd. shall not be responsible for, any loss arising 
in connection with the purchase or use of any Amplivox Ltd. product that has been:  

• repaired by anyone other than an authorized Amplivox Ltd. service representative;  

• altered in any way so as, in Amplivox Ltd. opinion, to affect its stability or reliability;  

• subject to misuse or negligence or accident, or that has had the serial or lot number altered; defaced or 

removed; or  

• improperly maintained or used in any manner other than in accordance with the instructions provided by 

Amplivox Ltd. 

This warranty is in lieu of all other warranties, express or implied, and of all other obligations or liabilities of Amplivox 
Ltd. Amplivox Ltd. does not give or grant, directly or indirectly, the authority to any representative or other person to 
assume on behalf of Amplivox Ltd. any other liability in connection with the sale of Amplivox Ltd. products.  
 
AMPLIVOX LTD. DISCLAIMS ALL OTHER WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING ANY WARRANTY OF 
MERCHANTABILITY OR FOR FUNCTION OF FITNESS FOR A PARTICULAR PURPOSE OR APPLICATION. 
 

9.7. CALIBRATION AND RETURN OF THE INSTRUMENT  

Amplivox recommends that the CA850/4A is calibrated annually.  
Please contact Amplivox or the designated distributor for details of calibration services. 
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10. TECHNICAL SPECIFICATIONS 

10.1. STANDARDS AND REGULATORY 

Type of protection against electric shock: Powered via SELV ClassII mains adapter 

Degree of protection against electric shock: Type B applied part 

Degree of protection against ingress of water: Not protected 

Mode of operation: Continuous operation 

Equipment mobility: Portable 

 

The CA850/4A Audiometer is classified as a Class IIa device under Annex IX of the EU Medical Devices Directive. It is 

intended for use as a screening audiometer instrument. 

 

Audiometer type: Type 4 (IEC 60645-1:2001) 

                                 Type 4 (ANSI S3.6:2004) 

 

Types and reference levels: DD45: ISO 389-1, Table 2 

Static headband force: Headphones: 4.5N 

Sound attenuation characteristics: ISO8253-1, Table 3 

 

10.2. INPUT/OUTPUT DATA 

Outputs:    Left & Right earphone 

Frequency range:   250Hz-8kHz 

Frequency accuracy:   <1% 

Distortion:   <2% 

Output level range:   -10dBHL min; 100dBHL max (all frequencies) 

Output level accuracy:   Within 3dB 

Output level step size:        5dB 

Output transducer (AC):   DD45 earphones (supplied) 

Tone present:   Single tone 

Communication:    Integral talk over facility 

USB interface:   Interface to PC (CA850/4A & CA850/4A Database / Amplisuite software) 

Power input:   2.5mm barrel-type socket. 

Patient response input:   6.3mm Jack socket 

Left & Right outputs:   6.3mm Jack socket 

USB:   Type B socket 

Maximum voltage at any output: 12V peak 

 

10.3. PHYSICAL DATA 

Display: 2 lines of 24 characters 

Mains power: 100-240Vac; 50-60Hz; 0.5A 

Input Rating:  5Vdc; 1.2A 

Dimensions: 270mm (W) x 175mm (D) x 68mm (H) 

Weight: 0.75kg (approx.) 

Safety: IEC 60601-1 (plus UL, CSA & EN deviations) 

EMC: IEC 60601-1-2 
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CE mark: To the EU Medical Device Register 

10.4. EARPHONE SOUND ATTENUATION CHARACTERISTICS 

Frequency, Hz 250 500 1000 2000 4000 8000 

Attenuation, dB 5 7 15 25 31 23 

 

10.5. ENVIRONMENTAL 

Operating temperature: +15oC to +35oC 
Storage/transport temperature: -20oC to +70oC 
Humidity (operating): 30% to 90% (non-condensing) 
Humidity storage/transport): 10% to 90% (non-condensing) 
Atmospheric Pressure (operating): 700hPa to 1060hPa 
Atmospheric Pressure 
(storage/transport):  
 

500hPa to 1060hPa 

 

  



   
 EMC GUIDANCE & MANUFACTURER’S DECLARATION 

 
 

 

41   CA850/4A INSTRUCTION FOR USE                                                                                                                   D-0131946-C
  

 

11. EMC GUIDANCE & MANUFACTURER’S DECLARATION 

 

• This instrument is suitable in hospital environments except for near active HF surgical equipment and RF 

shielded rooms of systems for magnetic resonance imaging, where the intensity of electromagnetic 

disturbance is high 

• Use of this instrument adjacent to or stacked with other equipment should be avoided because it could result 

in improper operation. If such use is necessary, this instrument and the other equipment should be observed 

to verify that they are operating normally 

• Use of accessories, transducers and cables other than those specified or provided by the manufacturer of this 

equipment could result in increased electromagnetic emissions or decreased electromagnetic immunity of this 

equipment and result in improper operation. The list of accessories, transducers and cables can be found in 

this operating manual. 

• Portable RF communications equipment (including peripherals such as antenna cables and external antennas) 

should be used no closer than 30 cm (12 inches) to any part of this instrument, including cables specified by 

the manufacturer. Otherwise, degradation of the performance of this equipment could result 

NOTICE 

• ESSENTIAL PERFORMANCE for this instrument is defined by the manufacturer as:  

This instrument does not have an ESSENTIAL PERFORMANCE Absence or loss of ESSENTIAL PERFORMANCE 

cannot lead to any unacceptable immediate risk 

• Final diagnosis shall always be based on clinical knowledge There are no deviations from the collateral standard 

and allowances uses 

• This instrument is in compliance with IEC60601-1-2:2014, emission class B group 1 

NOTICE: There are no deviations from the collateral standard and allowances uses 

NOTICE: All necessary instruction for maintaining compliance with regard to EMC can be found in the general 

maintenance section in this instruction. No further steps required.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

CAUTION 
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Guidance and manufacturer’s declaration – electromagnetic emissions 

The CA850/4A Audiometer is intended for use in the electromagnetic environment specified below. The customer 

or user of CA850/4A Audiometer should assure that it is used in such an environment. 

Emissions test 
Compliance Electromagnetic environment – guidance 

RF emissions 

 

CISPR 11 

Group 1 
The CA850/4A Audiometer uses RF energy only 

for its internal function. Therefore, its RF 

emissions are very low and are not likely to cause 

interference in nearby electronic equipment. 

RF emissions 

 

CISPR 11 

Class B The CA850/4A Audiometer is suitable for use in 

all establishments, including domestic 

establishments and those directly connected to 

the public low-voltage power supply network that 

supplies buildings used for domestic purposes. Harmonic emissions 

 

IEC 61000-3-2 

Class A 

Voltage fluctuations/flicker 

emissions 

 

IEC 61000-3-3 

Complies 

 

 

 

Guidance and manufacturer’s declaration – electromagnetic immunity (1) 

The CA8504A Audiometer is intended for use in the electromagnetic environment specified below. The customer 

or user of the CA850/4A Audiometer should assure that it is used in such an environment. 

Immunity test IEC 60601 test level Compliance level Electromagnetic 

environment – guidance 

Electrostatic Discharge (ESD) 

 

IEC 61000-4-2 

±8 kV contact 

 

±15 kV air 

±8 kV contact 

 

±15 kV air 

Floors should be wood, 

concrete or ceramic tile. If 

floors are covered with 

synthetic material, the relative 

humidity should be at least 

30% 
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Immunity test IEC 60601 test level Compliance level 
Electromagnetic 

environment – guidance 

Voltage dips, short interruptions 

and voltage variations on power 

supply input lines (100V/60Hz & 

240V/50Hz) 

 

IEC 61000-4-11 

0% UT 

(100% dip in UT) for 

0.5 cycle 

 

0% UT 

(100% dip in UT) for 1 

cycle 

 

40% UT 

(60% dip in UT) for 5 

cycles 

 

70% UT 

(30% dip in UT) for 

500ms 

 

0% UT 

(100% dip in UT) for 5 

sec 

0% UT 

100% dip in UT) for 0.5 

cycle 

 

0% UT 

(100% dip in UT) for 1 

cycle 

 

40% UT 

(60% dip in UT) for 5 

cycles 

 

70% UT 

(30% dip in UT) for 

500ms 

 

0% UT 

(100% dip in UT) for 5 

sec 

Mains power quality should be 

that of a typical commercial or 

hospital environment. If the 

user of the CA850/4A 

Audiometer requires continued 

operation during power mains 

interruptions, it is 

recommended that the 

CA850/4A Audiometer be 

powered from an 

uninterruptible power supply or 

a battery 

Power frequency (50/60Hz) 

magnetic field 

 

IEC 61000-4-8 

30 A/m 30 A/m Power frequency magnetic 

fields should be at levels 

characteristic of a typical 

location in a typical 

commercial or hospital 

environment. 
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Guidance and manufacturer’s declaration – electromagnetic immunity (2) 

The CA850/4A Audiometer is intended for use in the electromagnetic environment specified below. The customer 

or user of the CA850/4A Audiometer should assure that it is used in such an environment. 

Immunity test IEC 60601 test 

level 

Compliance level Electromagnetic environment – guidance 

 

 

 

 

 

 

 

 

Conducted RF 

IEC 61000-4-6 

 

Radiated RF 

IEC 61000-4-3 

 

 

 

 

 

 

 

 

10 Vrms 

150kHz to 80MHz 

 

10 V/m 

80MHz to 2.7GHz 

 

 

 

 

 

 

 

 

10 Vrms 

150kHz to 80MHz 

 

10 V/m 

80MHz to 2.7GHz 

Portable and mobile RF communications 

equipment should be used no closer to any part 

of the CA850/4A  Audiometer, including cables, 

than the recommended separation distance 

calculated from the equation applicable to the 

frequency of the transmitter. 

Recommended separation distance 

d = 1.2√P 

d = 1.2√P 80MHz to 800MHz 

d = 2.3√P 800MHz to 2.7GHz 

where P is the maximum output power rating of 

the transmitter in Watts (W) according to the 

transmitter manufacturer and d is the 

recommended separation distance in metres (m). 

 

Field strengths from fixed RF transmitters, as 

determined by an electromagnetic site survey, a 

should be less than the compliance level in each 

frequency range. b 

Interference may occur in the vicinity of 

equipment marked with the following symbol: 

 

 

 

 

NOTE 1 At 80MHz and 800MHz, the higher frequency range applies. 

NOTE 2 These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption 

and reflection from structures, objects and people. 

a Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless) telephones and 

land mobile radios, amateur radio, AM and FM radio broadcast and TV broadcast cannot be predicted 

theoretically with accuracy. To assess the electromagnetic environment due to fixed RF transmitters, an 

electromagnetic site survey should be considered. If the measured field strength in the location in which 

the CA850/4A Audiometer is used exceeds the applicable RF compliance level above, the CA850/4A 

Audiometer should be observed to verify normal operation. If abnormal performance is observed, 

additional measures may be necessary, such as re-orienting or relocating CA850/4A Audiometer. 

b Over the frequency range 150 kHz to 80 MHz, field strengths should be less than 3 V/m. 
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Guidance and manufacturer’s declaration – electromagnetic immunity (2) 

Recommended separation distances between portable and mobile RF communications equipment and 

the CA850/4A Audiometer 

The CA850/4A Audiometer is intended for use in an electromagnetic environment in which radiated RF 

disturbances are controlled. The customer or the user of the CA850/4A  Audiometer can help prevent 

electromagnetic interference by maintaining a minimum distance between portable and mobile RF 

communications equipment (transmitters) and the CA850/4A  Audiometer as recommended below, according to 

the maximum output power of the communications equipment. 

Rated maximum output 

power of transmitter 

 

W 

Separation distance according to frequency of transmitter 

 

m 

150 kHz to 80 MHz 

 

d = 1.2√P 

 

80 MHz to 800 MHz 

 

d = 1.2√P 

800 MHz to 2.5 GHz 

 

d = 2.3√P 

0.01 0.12 0.12 0.23 

0.1 0.38 0.38 0.73 

1 1.2 1.2 2.3 

10 3.8 3.8 7.3 

100 12 12 23 

For transmitters rated at a maximum output power not listed above, the recommended separation distance d in 

metres (m) can be estimated using the equation applicable to the frequency of the transmitter, where P is the 

maximum output power rating of the transmitter in Watts (W) according to the transmitter manufacturer. 

NOTE 1 At 80MHz and 800MHz, the separation distance for the higher frequency range applies. 

NOTE 2 These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption 

and reflection from structures, objects and people. 

 

NOTE 3 WARNING: Portable RF communications equipment (including peripherals such as antenna cables and 

external antennas) should be used no closer than 30cm (12 inches) to any part of the CA850/4A audiometer including 

cables specified by the manufacturer. Otherwise degradation of the performance of this equipment could result. 
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12. USE WITH NON-MEDICAL ELECTRICAL EQUIPMENT 
Any person who connects external equipment to signal input, signal output or other connectors has created a medical 

electrical system and is therefore responsible for the system complying with the requirements of clause 16 of IEC 60601-

1:2005 (General requirements for basic safety and essential performance). 

If connections are made to standard equipment such as printers and computers, special precautions must be taken in 

order to maintain medical safety. The following notes are provided for guidance in making such connections to ensure 

that the general requirements of clause 16 of IEC 60601-1:2005 are met. 

The following signal inputs and outputs on the Amplivox CA850/4A audiometer are electrically isolated to the 

requirements of IEC 60601-1 in order to reduce any potential hazard associated with the use of mains-powered 

equipment connected to these inputs and outputs: 

 

Socket Label Socket Type Typical Connection 

USB USB Connector 

Type B 

Computer 

 

External equipment intended for connection to signal input, signal output or other connectors, shall comply with the 

relevant IEC or international standards (e.g. IEC 60950, CISPR 22 & CISPR 24 for IT equipment, and the IEC 60601 series 

for medical electrical equipment). 

Equipment not complying with IEC 60601 shall be kept outside the patient environment, as defined in IEC 60601-

1:2005 (at least 1.5m from the patient). The operator must not touch the connected equipment and the patient at 

the same time as this would result in an unacceptable hazard. 

Refer to Diagrams 1 & 2 below for typical configurations of connected peripheral equipment.  

Refer to Amplivox Ltd at the address given on the front of this user manual if advice is required regarding the use of 

peripheral equipment. 
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Diagram 1: CA850/4A used with the medically-approved mains adapter 

 

                  Mains Outlet                                  Medical Mains Adapter 

 

 

 

  

 

 

 

 

                                                        CA850/4A Audiometer 
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Diagram 2: CA850/4A used with the medically-approved mains adapter and PC 

 

                        Mains Outlet                                                          Medical Mains Adapter 

                   

                                                                                                                               

                         Mains Outlet                                                                   CA850/4A Audiometer                   

                                                      

                                                                                                                                         

     

                         PC Power Supply                                                           PC via USB Socket 
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13. AMPLISUITE INSTALLATION 

13.1. PRE-INSTALLATION NOTES 

13.1.1. PC AND SYSTEM REQUIREMENTS 

The PC-requirements are as follows: 

• Processor: 1 GHz or faster, one or multi-core 

• RAM: 1 GB or more 

• Available hard disk space: minimum 200 MB 

• Resolution: minimum 1378 x 768 

• Graphics device: DirectX 9 with WDDM 1.0 or higher driver 

• Available 2.0 or 3.0 USB Port 

 

13.1.2. OPERATING SYSTEM COMPATIBILITY 

Amplisuite is supported on the Microsoft Windows 10 Operating System. 

 

13.2. INSTALLATION 

13.2.1. GENERAL 

Installation is a straightforward process, but the steps must be carried out in the correct order. To ensure you are familiar 

with the instructions please read this entire user manual before commencing installation. 

 

13.2.2. AMPLISUITE SIN SOFTWARE INSTALLATION PACKAGE 

Run ampliSuiteInstaller.exe 

Select Run to any security warnings that are displayed: 

 

 

If desired, change the installation location by Options. Select Install on the welcome screen to proceed with the 

installation: 
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Select Next to proceed with the installation: 

  

 

Select Install to proceed with the installation: 
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Amplisuite installation will then commence: 

 

Amplisuite installation will continue until complete. Tick the box to install the USB drivers if you don’t currently have 

the latest Amplivox USB drivers installed. Select Finish. 

 

To start Amplisuite, select Amplisuite from the start menu or the Amplisuite icon on the desktop. 

 

The Amplisuite Software can also be started by double-clicking on the ampliSuite.exe file. A desktop shortcut to this 

may be created if desired.  
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14. AMPLISUITE SIN SOFTWARE 

14.1. SETTINGS: PASSWORD 

The default password for the settings is: Audiocups. 

 

14.2. ABOUT AMPLISUITE 

14.2.1. GENERAL 

 

Open Amplisuite by double-clicking on the shortcut icon on the desktop.  

 

The Suite will start in the tone audiometry module, as shown below. The audiometry module consists of patient 

information (1), the currently uploaded session details (2), the control bar (3), audiograms for the left and right ear in 

table (4) and diagram format and the PTA calculation, HSE categorisation and SiN test outcome (5). 

    

 

 

14.2.2. SELECTION OF AC, BC AND UCL 

In the toolbar, select the corresponding icon of the graph that shall be plotted. The following selection is possible: 

 
 

Air Conduction (AC): Select this icon to plot the air conduction. 

 
 

Bone Conduction (BC): Not Applicable 

 

U-Threshold (UCL/ULL): Not Applicable 

 

 

1 

2 

3 

5 

4 
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Masking: Not Applicable 

 

Not heard/no response (NR): Select this icon in addition to AC or BC to mark a not heard point. 

 Please note: The data shown in the table below the graph, plotted or deleted is always equivalent to the selection 

(AC, BC, UCL) made in the toolbar. If the air conduction is selected, no bone data can be deleted and vice versa.  

 

14.2.3. COUNSELLING OVERLAYS 

It might be desired to use additional explanation tools to help the patient better understand his or her hearing threshold. 

 
 

Speech Banana: Will show the speech area as it is selected in the settings. 

 
 

 

Hearing Levels: Will show the degrees of hearing loss based on the World Health Organization’s (WHO) 
recommendation. 
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14.2.4. MANUAL ENTRY OF DATA 

There are different options to enter test data. Data can be plotted directly into the graph using the mouse or the 

keyboard, or the Manual Entry Table below the audiogram. 

Select the desired ear and test method (AC, BC, UCL, (un)masked and NR) to start plotting data.  

 

   

Mouse: Use the mouse to move the 
cursor to the desired 
frequency and level. 

Double-click left and store 
the test point. 

Right-click at any level of the 
frequency to delete the test 
point again. 
 

Keyboard: Use the arrow keys to move 
the cursor to the desired 
frequency and level. 

Hit the Enter-key or S-key on 
the keyboard to store the 
test point. 

Hit the Delete key on the 
keyboard at any level of the 
frequency to delete the test 
point again. 
 

As soon as the point has been entered, the table below the graph will show the equivalent value. 

Manual Entry Table: Click in the table below the graph to enter the corresponding level of the selected frequency. The 

top row represents the Air or Bone conduction values, whereas the second row represents the masking values, if any 

exist. To move to the next cell, press the Tab key. 
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14.2.5. MASKING 

Masking values can be added in two different ways. 

Either, the masking button  in the toolbar is 

selected together with the AC  or BC  function, 
or the Manual Entry table is used to manually add the 
masking values.  
 
When masking is used, but the actual masking value is 
unknown, the table will show an M to indicate masking 
was active. If the masking value is known, a number will 
show in the second row of the table. 
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14.2.6. NO RESPONSE 

In the case where the patient did not respond to the 
test signal, the symbol of no response (NR) can be 
added to the audiogram.  

Select the NR button  in the toolbar together with 

the AC  or BC  function to mark the level as 
not heard.  
 
 

 

 

14.2.7. DELETE A TEST POINT 

In case a test point was placed incorrectly and should be removed, it is possible to delete a test point. Select the 

threshold that should be removed (air or bone) and move the mouse over the corresponding level, ideally the test point, 

to be deleted. 

To delete the point, select the delete button on the keyboard or click the right button on the mouse. 

 

14.3. ADD PATIENTS TEST DETAILS 

 

To enter basic patient information, click on the patient name on the top of left side 
corner of the session bar. If no patient name has been assigned yet, the patient is called 
No name. 
 
The patient details form will then be displayed. Enter the patient details and select OK. 
The details will then be displayed on the main patients details screen. 
The information provided will be included in the patient printout. 
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When the patient information is recorded, we recommend to continue running a screening audiometry test using the 

Audiometer. 

Hearing test results can only be categorised to HSE standards when a subjects Gender and Date of Birth have been 

entered. 

 

14.4. STARTING AUDIOMETER CONTROL PC SOFTWARE 

From Amplisuite, the PC software can be started to run a screening audiometry test. Please refer to the instruction of 

use on how to conduct a test using the equipment. 

 

Run otosure.exe to perform test (PLEASE NOTE that a connected device is required). 
Please refer to the Otosure software sections of this user manual for instructions on how 
to use the Otosure software. 
 
 

 

As soon as a test is downloaded and selected, the result will be shown, and further 
details can be found in the session panel. 

 

14.5. BASELINE COMPARISON 

 

Measurements obtained for the same patients can be overlapped and displayed at 
the same time for review purposes. 
 
To show several curves at once, select the check box next of the test you want to 
display. The selected thresholds will be shown in different colour to allow a 
differentiation of the different measurements. The colour will be displayed next to 
the selected test. 
 
To override previous test dates before saving, click the Data and override with 
desired date. For HSE (Category 4) comparison, ensure the relevant dates are 
within the given timeframe. 
 

 Please note: You can show up to 10 tests at once. If you select more then 10, 
the first selected test will be deselected. 
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14.5.1.1. HSE CATEGORISATION TABLE 

 

This table shows HSE categorisation for each ear. The first row presents right 
/ left ear label, next shows category from 1 to 3, next is for 4th category. It can 
contain Cat4 – No data, Cat4 or be empty depending on audiogram and historical 
data. In the last row of the table information about any UNILATERAL HEARING 
LOSS, if it occurs, is shown. 

 

14.5.1.2. PTA CALCULATION 

 

An automatic PTA calculation takes place when adding air conduction values and will 
be visible for each ear in the Audiometry Data table, shown below the audiograms. 

The PTA is calculated from the average of the hearing threshold for specific test 
frequencies. These specific frequencies can be customised in the audiometry settings. 
 

 

14.6. SETTINGS 

14.6.1. GENERAL & PASSWORD 

Selecting the settings button  at the top of Amplisuite will open a pop-up with all available settings for the 

audiometry modules. Settings are protected by the password: Audiocups 
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14.6.2. AUDIOMETRY SETTINGS 

14.6.2.1. LAYOUT OF THE AUDIOGRAMS 
Depending on your preferences, you might like to have the audiogram of the right ear displayed on your right-hand side 

and the one of the left ear on your left-hand side. In this case, select Left ear on left side. 

Others prefer to see the audiogram arrangement according to the patients view. In this case, select Left ear on right 

side. 

If you want to see the thresholds for both ears on one audiogram, please select Both ears on the same graph. 

14.6.2.2. AUDIOGRAM ICON SET 
The audiogram icons used in the audiometry module might be dependent on your location. The Amplisuite audiometry 

module offers you 5 different icon sets, based on your location: ASHA (US), Australia, BSA (UK) or Hong Kong. 

 

14.6.3. CATEGORISATION  

The categorisation of hearing levels can be selected here. CoP Standard, or PULHEEMS. Where different levels to the 

CoP standard (PULHEEMS H2) need to be selected, values can be overwritten in the Acceptable Levels section.  

 

14.7. PRE EMPLOYMENT 

Select PRE EMPLOYMENT to find the pre employment settings on the right-hand side. Check both boxes (enable pre 

employment), so that Amplisuite will inform you when a speech in noise test is required. This standard is used by some 

services and establishes the average hearing level (dB) across 0.5,1,2,3,4 and 6kHz. 
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14.7.1. CHANGING LANGUAGE 

Select SETTINGS in the upper right corner of Amplisuite. A popup will open with all available Amplisuite settings. Select 

GENERAL to find the language settings on the left-hand side. 

 

The following languages are available to use in the Amplisuite: Chinese (中文), English, Estonian (eesti), French 

(français), German (Deutsch), Hebrow ( ִעברית ), Hungarian (magyar), Italian (italiano), Japanese (日本語), Korean 

(한국어), Polish (polski), Portugese (português), Russian (pусский), Serbian (srpski), Spanish (español), Turkish (Türkçe) 

or Vietnamese (Tiếng Việt). 

Select the language you would like Amplisuite to be in and confirm the change by clicking OK. Amplisuite will require a 

restart for the changes to take place. 

 

14.7.2. HELP 

Under HELP the Amplisuite manual is stored. The manual can also be opened from every screen by pressing the F1 key.  

 

14.7.3. ABOUT 

In the About section you can find useful information about Amplivox. You can contact us directly via email or access our 

website.   

 

 

 

 

 

 

 

 

 

 

 

 

 

https://en.wiktionary.org/wiki/%ED%95%9C%EA%B5%AD%EC%96%B4
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14.7.4. TROUBLESHOOTING 

 Please note: Refer to the installation & operating instructions provided with your instrument(s) for details of the 

data transfer operation and errors that could possibly occur. If a fault cannot be fixed, the operator is cautioned against 

repeatedly restarting the instrument. 

 

 

PROBLEM 

 

CAUSE 
 

SOLUTION(S) 

Instrument doesn’t connect. 

 

• Device is not switched on 

• USB connection unstable 

• Switch on /Restart device 

• Check USB connection in both 
instrument and PC 

• Ensure cable is in good 
working order 

No data is transferred to PC. • Specified location to store data 
is different than expected 

• Specified location to store data 
does not exist 

• LoadIt.exe is stored in a 

different location 

• Review the store 
location in the settings 

• Store LoadIt.exe in same folder 
as ampliSuite.exe 

Not all tests completed 
 

• A subject may have difficulty 
getting used to the test or 
unable to get a result in one 
ear. 

• In this instance, the subject 
can be retested where they 
have been unable to complete 
a test. Results can be 
combined and will require 
manual addition. 

Error 20 type b 

 

• USB connection to CA850/4A 

unstable  

• Switch on /Restart device 

• Check USB connection in both 
instrument and PC 

• Ensure cable is in good 
working order 

 

• CA850/4A is not switched on 

• USB connection to CA850/4A 

unstable 

• Press the Play / SiN button 

again. 

• Switch on /Restart device 

• Check USB connection in both 
instrument and PC 

• Ensure cable is in good working 

order 
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Subject cannot hear a command in an 
ear or gain a threshold. 
 

• If a test result is shown as 
Incomplete or No SNR, the 
system has not been able to 
establish a repeatable 
threshold for that test or ear. 

• In this case, it would be 
advisable to retest the subject 
with a higher starting level 
(70dB), and potentially one 
part of a test at a time. If a 
subject still cannot hear and 
respond correctly, their 
hearing ability cannot be 
assessed with this test.  
 

Starting level set at 70dB, subject 
cannot understand a command. 
 

• Subject’s hearing may be too 
poor to be able to identify a 
SRT with this test. 

• Subject is unwilling to 
participate in the test. 

• If a subject cannot hear and 
respond correctly to establish 
a SRT threshold, their hearing 
ability cannot be assessed with 
this test.  
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15. CA850/4A DATABASE INTRODUCTION 

15.1. OVERVIEW 

CA850/4A Database is the hub of a suite of programs and instruments designed to enable health care professionals to 
automatically test patient’s hearing levels using a connected audiometer, to download the test data & display 
audiograms and then analyse & categorise the results. 
 
Information on each patient is displayed simply and clearly, with a patient’s details page and a separate screen for each 
audiometric test. The user can step through each screen easily by selecting the appropriate page on the screen. Although 
multiple records of many patients may be stored together on the same PC, the database rapidly recalls any records for 
a particular patient once a unique part of the information, for instance the patient number, is entered into the filter 
screen. 
 
CA850/4A Database stores different audiometric records for the same patient as independent records, but the user can 
view them all, once any one of them has been recalled. Such audiometric records are presented graphically, 
superimposing automatically the latest test results on the previous results stored, enabling the user to make a direct 
visual comparison between the two. 
 
CA850/4A Database has facilities for printing either individual audiograms or a database summary. Using the filter 

function, the user can also print the summary of a sub-section of the database such as the names of all patients due to 

be retested between two dates, all patients with a particular categorisation or records of patients above, below or equal 

to a particular age. 

 

A key feature of CA850/4A Database is its ability to interface to a range of Amplivox audiometers with USB connectivity, 
allowing audiometric test data to be transferred easily from the audiometer. When used with the CA850/4A audiometer 
the CA850/4A Database may also launch an automatic audiometric test, again seamlessly transferring the results back 
into CA850/4A Database. 
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16. COMPUTER REQUIREMENTS 

16.1. COMPUTER HARDWARE 

The requirements for CA850/4A Database are the same as for the operating system being used on that hardware. As a 
guide: 
 

• 1 GHz processor (32-bit or 64-bit) 

• Video resolution 1024 by 768 minimum 

• 1 GB of RAM (32-bit processor); 2 GB of RAM (64-bit processor) 

• 16 GB of available disk space (32-bit processor); 20 GB of available disk space (64-bit processor)  

• DirectX 9 graphics device with WDDM 1.0 or higher driver 
 
The printer designated by the Windows operating system will be used as the default printer. In addition one free USB 
port is required to connect an Amplivox audiometer and for CA850/4A Database installation purposes. 
 

16.2. COMPUTER SOFTWARE 

The CA850/4A Database software suite is supplied on a USB stick along with device drivers and other programs to allow 
connection to Amplivox audiometers. 
 
CA850/4A Database is supported on the Microsoft Windows 10 Operating System. 
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17. INSTALLING CA850/4A DATABASE 
 

17.1. ADMINISTRATOR AND USER PERMISSIONS 

It is often the case that a user with “administrator” permissions is allowed to install and/or upgrade application software, 
while the user of the application has a “standard user” account. In line with this scheme, the CA850-4A Database folder 
will need to have at least “read & execute” and “write” permissions set on it for the intended user. However, depending 
on the precise configuration of the computer it may be necessary to grant “full control” to this folder, or even grant the 
CA850/4A Database user “administrator” rights. 
 
It is recommended that the Windows User Account Control is set to “never notify” (Control Panel → User Accounts → 
Change User Account Control Settings). If this is not done, then certain functions within CA850/4A Database will be 
restricted and this may result in error messages. 
 

17.2. INSTALLATION PROCEDURE 

Installation is a straightforward process but the steps must be carried out in the correct order. To ensure you are 
familiar with the instructions please read this entire user manual before commencing installation. 

 
Ensure that the Windows date & time formats (in the Region & Language group) are set to dd/mm/yyyy and hh:mm:ss 
(without AM or PM displayed). If this is not done CA850/4A Database may display error messages. 
 
The process described below refers to a “typical” installation on a new PC. Depending on the actual configuration of the 
PC being used and whether any previous versions of software and/or device drivers have been installed some alternative 
steps may be needed. Please refer to the CA850/4A Database troubleshooting section for further guidance. 

Installation is a two-stage process (please ensure both are completed): 
1) With the audiometer disconnected from the PC, install the CA850/4A Database software on the PC  
2) With the audiometer still disconnected from the PC, install the Amplivox device drivers to enable USB 

communication between the PC and the audiometer.  

17.2.1. INSTALL THE CA850/4A DATABASE SOFTWARE 

a) Disconnect any USB based audiometer from the PC. 
b) Switch on the computer and wait until the Windows desktop appears on-screen. Do not open any other applications 

before installing CA850/4A Database. If any programs start, close them before proceeding to the next step. 
c) Insert the Amplivox software USB stick and navigate to the USB stick. 
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d) Then select ‘setup.exe’ and follow the on-screen commands. 

 

 
 
e) The following screen will be displayed first. If you have any other applications running, click ‘Exit Setup’, and close 

the running applications and return to step d). If no other applications are running, click ‘OK’. 
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f) When the installation screen (below) is displayed the location for the program files may be selected. 
 

 
 
g) The default installation directory is as shown (example shows a 64-bit operating system). To install to a different 

directory, click ‘Change Directory’ and select the required directory. If installing on a network, install the program 
on the computer that will be used to hold patient test results and run tests on patients. 

h) The option to select an alternative program group is then presented. 
 

 
 
i) To use the default group click ‘Continue’ to proceed. 
j) If updates, Windows or otherwise have been applied to the PC, it is possible that the following conflict message 

may be displayed one or more times. Select ‘Yes’ to each instance of any displayed message. 
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k) Click ‘OK’ on the final dialogue box to complete the installation. 
 

 
 
l) Continue with the device driver installation (below). 
 

17.2.2. INSTALL THE AUDIOMETER USB DEVICE DRIVERS 

a) Navigate to the USB stick. Select the ‘USB drivers’ folder and select ‘Setup’. 
 

 
 

b) Install the USB Drivers from step b) as described in the Amplivox Operating Manual for USB Driver Installation (D-
0115682). This can be found in the same location as this operating manual. Do not connect the audiometer to the 
PC until instructed to do so. 
 

If the latest version of the USB drivers are already installed, for example if an Amplivox audiometer or 

tympanometer has previously been connected to the PC, performing the installation again is not necessary. 

However, there are no adverse consequences in doing so – the steps f), g) & h) in Section 3 of the Operating Manual 

for USB Driver Installation will be skipped, and when connected your instrument will be immediately ready for use. 
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18. STARTING CA850/4A DATABASE 
• Click Start from the task bar at the bottom of the screen 

• Select the CA850-4A Database group and click CA850-4A Database to open the program 
 
Alternatively, a shortcut icon may be placed on the Desktop in the usual way. 
 

Product Registration 
 
Before use, CA850/4A Database needs to be registered with Amplivox. The screen shown below will be displayed when 
opening CA850/4A Database for the first time: 
 

 
 
Call or email Amplivox with the following details: 
 

• the CA850/4A instrument serial number 

• the Software Number from the registration screen 

• the CA850/4A Database serial number (located on media label) 
 
Please make sure that upper and lower case letters are correctly identified. A Registration Key will be provided by return 
to be entered as shown above. 
 
A screen requesting a Username and Password will then appear: 
 

 
 
The use of a Username and Password is optional but the latter can act a means of security if required. The Username is 
not saved by CA850/4A Database and would typically be the name of the operator (if entered, this name is displayed as 
the “Examiner” on the Details page ). To skip the entry of Username and Password click on OK. 
 
If required, enter a Username and click OK without entering a password. A password (if required) is entered later. 
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The screen below, the Register Screen, will then be displayed. Initially this will be blank as no patient details have been 
established. The menu bar and tool bar contain the functions that are required for the storage and analysis of 
audiometric test results. 
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19. AUDIOLOGY MENU BAR FUNCTIONS 
 
 
 
Selecting any of these functions will provide a drop-down menu with further options. Click on the option required. For 
further information on the use of each option see the section listed below. 
 

19.1. DROP-DOWN MENUS 

File Import  Database Find 
      Import File   Filter Criteria 
      Import Audibase 3.1   Sort 
 Export   Create Average 
 Print Preview        Add New Average 
 Print        Insert Average 
 Batch Print  Help About 
 Exit    
Setup Configuration    
Test Launch Test    
Edit Add Patient    
 Insert Audiogram    
 Edit    
 Save    
 Cancel Insert/Edit    
 Change Patient No.    
 Delete a Record    
 Delete a Patient    

 

19.2. HELP 

The About menu provides the CA850/4A Database version number as well as details of a lower-level software module 
(the “Loadit” interface) along with support contact information. Please quote these details when contacting Amplivox 
with any technical queries. 
 

   

File    Setup    Test    Edit    Database    Help 
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20. AUDIOLOGY TOOL BAR FUNCTIONS 
The tool bar displays a number of function icons. When the mouse is positioned over an icon, a tooltip will identify the 
function of the icon. To start the function, click the icon. 
 

20.1. PREVIOUS PATIENT; NEXT PATIENT   

 

These two functions enable the user to move between patient records, the arrowhead in the first 
column of the register page showing which patient is currently selected. 

 

20.2. NEW PATIENT   

 

Click on this icon to enter Edit mode and to insert the details of a new patient into the Patient’s 
Details page. 
 

 

20.3. FIND   

 

 

 
Click this icon to search the database for a specific record. 
 

20.4. QUESTIONS   

 

Access the patient questionnaire after a test has been run and when in Edit mode by clicking this 

icon. If this function is required prior to the actual test click the Insert Audiogram  icon on the 
tool bar. 

 

20.5. LAUNCH TEST   

 

This can only be used with a connected Amplivox CA850/4A audiometer. Use this function to start 
running a test on the CA850/4A. Remember to save the audiogram at the end of the test. 

 
Note: if no patient records exist (e.g. after installation) it will not be possible to launch a test until a new patient is 
added  
 

20.6. SAVE   

 

Click this icon to save any changes to a patient’s records or test results. 
 

 

20.7. FILTER   

 

Click this icon to bring up the filter function. Insert the search criteria and click Apply Filter at the 
bottom of the screen. To select the current record only, click Current Record at the bottom of the 
screen. Alternatively, to search by one of the current patient’s criteria, click Current next to the 
appropriate field. To clear the filter before using a different filter, click Clear Filter. 
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20.8. SORT   

 

Use this icon to rearrange the order in which the database is presented on the Register screen. 
Make the selection and click OK. 
 

 

20.9. PRINT PREVIEW   

 

Click this icon to bring up the Print Options box and choose between printing the currently selected 
audiogram or a summary of the filtered database. Make your choice and click OK. The Print Preview 
screen will appear. To print, click the printer icon found in the top lefthand corner of the 
screen. 
 

 To print directly without displaying the preview screen use File then Print from the menu bar and 
choose audiogram or database summary. 

 

20.9.1. PRINT AUDIOGRAMS 

The printout of the patient’s audiogram will include all the patient details, audiograms for left and right ear and the 
questionnaire. If the Audiogram Band option has been selected for printing then hearing performance bands will be 
printed on the audiogram. 

20.9.2. PRINT DATABASE SUMMARY 

The database summary printout shows details of the database selected. A summary of the whole database or a sub-
section of the database may be printed.  

To print the database in a particular sequence, first sort it by clicking Sort  and then choose how the database is 
to be sorted before using Print Preview. 

To print a particular subsection of the database (e.g. by Recall Date), click Filter and set the recall dates between 
which the filter is to be applied. Click Apply Filter and then go to Print Preview. 
 

20.9.3. PRINTING THE ENTIRE DATABASE (BATCH PRINT) 

All of the audiograms in the database may be printed using a single command. 
 
 
From the File drop-down menu select the Batch Print option as shown below: 
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A confirmation dialogue box will open which also gives the option to include printing the questionnaires. 

20.9.4. CHANGING THE USER DEFINED PRINTOUT TITLE 

To customise the printout title (i.e. Adding a company name), the section “[Print Report Title]” in the patient details file 
requires amending.  
 
 

20.10. EXPORT REGISTER DATA   

 

Use this icon to transfer the selected/displayed data as an electronic .csv (comma separated 
variable) file into another application (e.g. Microsoft Excel). 

 

20.11. EDIT   

 

Click this icon to enter Edit mode. Use this function to add details to or otherwise modify a patient’s 
record and use the Save icon to save the changes. 

 
To cancel an edit, or if the changes are not required, select the Edit drop-down menu and then the Cancel Insert/Edit 

option, or use the Cancel Insert/Edit  toolbar button. 
 
To amend an existing patient number, select the Edit drop-down menu and then the Change Patient Number option. 
Complete the dialogue box as required. 
 

20.12. INSERT AUDIOGRAM   

 

Use this function to manually enter a patient’s audiogram details onto the Audiogram screen. 
Please note that you can only enter results on the lower row of data boxes. 

 

20.13. DELETE RECORD   

 

Use this function to delete the currently selected audiogram. To completely delete a patient’s 
record, either delete each audiogram separately or use the Delete a Patient option from the Edit 
menu. 

 
Note: Use the Delete a Patient option with caution. The operation cannot be undone. It is recommended that a back-
up of the database is created first. 
 

20.14. CONFIGURE   

 

This function will allow the user to customise the settings used by the program. Clicking the 
Configure icon (or selecting Configuration on the Setup drop-down menu) will display the 
Configuration dialogue box: 
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There are five configuration pages relating to: 
 

• Backup/Repair 

• Database setup 

• Questionnaire 

• Test Analysis 

• Patient Options 
 
Access any of these pages by clicking on the appropriate page tab. 
 

20.15. BACKUP/REPAIR 

Use the two functions on this page to protect your data. 
 

20.15.1. MAKE BACKUP 

Select Make Backup to access a Save as... box to make a backup of the database. Select a name for the backup file and 
click Save. 

20.15.2. REPAIR DATABASE 

This function allows the user to repair a corrupt database. We suggest that you use this function if the database is not 
working correctly and you have not made a recent backup. Click Repair Database and the computer will try to repair the 
database. 

20.16. DATABASE SETUP 

The purpose of this page is to allow the user to change the default file used as the database file and to change/add 
password access. 
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20.16.1. CHANGING THE DEFAULT DATABASE 

To select a new database that you wish to use as the default database, click Browse, select the directory where the 
database is stored and click on the name of the new database. Click Open and a message will appear asking you to 
confirm the change. Click OK if you wish to change the default database, then close down and reopen CA850/4A 
Database. 

20.16.2. CHANGE PASSWORD 

To set up a new password or to change an existing one, click on Change Password in the Advanced Settings box, enter 
the current password (if any) and then enter the new password twice, confirming it the second time. Note the password 
you set is case sensitive. 
 
IMPORTANT: You must make a note of the password in order to ensure you have access to the database. If you forget 
the password you have set, you may not be able to access the database. 
 

20.16.3. SERIAL COM PORT 

Not applicable to the CA850/4A audiometer. 
 

20.17. QUESTIONNAIRE 

 
 
The purpose of this page is to enable the patient questionnaire supplied with the database to be tailored to specific 
requirements. To edit the questions, click Edit and make the appropriate changes. To save the changes, click OK. 
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20.18. TEST ANALYSIS 

 
 
The purpose of this page is to indicate which categorisation scheme(s) the program is currently using and to allow the 
selection to be changed. 
 
It also enables hearing performance bands to be displayed and printed on the audiograms in addition to displaying and 
printing a predictive band. To display performance bands on the audiograms, select Enabled in the Audiogram Band 
options. To print the hearing performance bands, select Print. Note: Print can only be selected if the Enabled option is 
also selected. To display and print a predictive band on the audiograms select Predictive.  
 
Note: Only suitably qualified practitioners should undertake the assessment of audiometric data. 
 
As an aid to this assessment CA850/4A Database produces a hearing categorisation once hearing thresholds and other 
patient data are established. 
 
One or more of the scheme(s) displayed in the Categorisation option may be selected as required followed by the 
‘Recategorise’ button. The revised categorisations will apply to all records in the database and confirmation is required. 
An alternative selection of categorisation scheme(s) may be made at any time and applied to the database, and the 
most recent selection will be saved when the program is closed. 
 
Details of the various categorisation scheme(s) available are provided in the following sections and the results of the 
selected categorisation(s) are displayed (as appropriate) at the bottom centre of the audiogram page. 

20.18.1. HSE CATEGORISATION 

This is derived from the UK Health & Safety Executive (HSE) scheme incorporated into the UK Control of Noise at Work 

Regulations 2005 (L108). These regulations define 5 categories of hearing as follows: 

• Category 1 – acceptable hearing ability 

• Category 2 – mild hearing impairment 

• Category 3 – poor hearing 

• Category 4 – rapid hearing loss (based on a previous test within 3 years) 

• Category U – unilateral hearing loss (based on a comparison of left & right ears) 

 

Each ear of a patient is placed into one (or more) of the above categories based on the hearing threshold results at a 

number of frequencies and the age and sex of the patient. Based on the resulting categorisation, a patient may be 

warned about hearing ability or referred for further medical advice. For detail of the derivation and application of these 

categories the user/operator is referred to the regulations. 
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As long as the required data is available (e.g. hearing thresholds have been established at the required frequencies) 

CA850/4A Database will perform this calculation and present the hearing categorisation results. 

The category identifier (1, 2, 3, 4 and ‘U’) will be followed by an associated coding which shows which part of the 

audiogram data caused the category identifier to be assigned. These identifiers are: 

• L (left) 

• R (right) 

• B (both) 

• no data (previous test data is not available) 

• Age < 18 (HSE tables do not cover this age range) 

• Data incomplete (required threshold data not available) 

Examples of HSE categorisations presented by CA850/4A Database: 

• 1 

• 1 4-no data U Age < 18 

• 2R 3L 4R U 

• 2B 4R U 

• 3B 4-no data U 

• 2R 3L 4L Age < 18 

• 2R 3L 4-no data U Age < 18 

• Data incomplete 

• No sex chosen 

• No sex chosen Age < 18 

• Invalid patient age (e.g. if date of birth age was not provided or is inconsistent) 

 

As shown above, to differentiate each part of the categorisation, there is a space between category identifiers. 

20.18.2. ARMY (H- PULHEEMS) CATEGORISATION 

The basis of audiometric assessment is the summing of high and low frequency levels in decibels (dB) over six 
frequencies. The frequencies used are 0.5, 1, 2, 3, 4 and 6 kilohertz (kHz); the low frequencies being 0.5, 1 and 2 kHz 
and the high frequencies 3, 4 and 6 kHz. The hearing in each ear is assessed and recorded separately. The higher value 
digit, representing the worst frequency group, determines the individual's overall hearing category for each ear. 
 
There are five grades of hearing acuity: 1, 2, 3, 4 and 8, described in the following table: 
 

Grades  Sum of hearing level at low 
frequencies in dB  

Sum of hearing level at high 
frequencies in dB  

General description  

1  Not more than 45. (RN only: No 
single level to be more than 
20dB)  

Not more than 45. (RN only: Level 
not to be more than 30 dB at 6 kHz 
or 20 dB at any other frequency)  

Good hearing  

2  Not more than 84  Not more than123  Acceptable hearing  

3  Not more than 150  Not more than 210  Impaired hearing.  

4  More than 150  More than 210  Poor hearing where continuing 
employment is subject to 
specialist assessment.  
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8  More than 150  More than 210  Poor hearing that has been 
assessed as being incompatible 
with continued service.  

20.19. PATIENT OPTIONS 

 
 
The purpose of this page is to enable the patient option dropdown lists (displayed on the register tab) to be populated 
with predefined options. To edit the patient options, click Edit and make the appropriate changes. To save the changes, 
click OK.  
 

20.20. CANCEL INSERT/EDIT   

 

Click this icon to cancel an insertion, or to discard changes if they are not required. The functionality 
is exactly the same as using the Edit drop-down menu and then the Cancel Insert/Edit option. 
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21. THE MAIN AUDIOLOGY SCREENS 

21.1. THE REGISTER SCREEN 

 
 
This screen when populated will show details of each patient. Use the left and right arrows at the top lefthand side of 
the screen to select a patient. 
 

21.2.  THE DETAILS PAGE 

 

Either click on the New Patient icon or click on the Details tab (if patient data is already loaded) to 
access the Details page below: 

 

 
 
Details may be added and/or edited for each patient as required. Ensure that for each patient a unique patient identifier 
number is used. 
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Note that CA850/4A Database automatically fills in several boxes in the Test area. They are: 

• The box labelled Examiner if a “Username” has been entered on the password screen. 

• The boxes labelled Test Type, Date of Test, Time of Test, Serial Number, Calibrated and Recall Date after a test 
has been run using the CA850/4A audiometer and the results saved in CA850/4A Database. 

 
Only enter data in the Test area if audiometric data is being entered manually or if a previously recorded audiogram is 
being entered and other pertinent details are to be recorded for display on the screen. 
 

21.3. EDITING DROP-DOWN MENUS ON THE DETAILS PAGE 

To facilitate data entry, commonly used items may be selected via drop-down menus. These include the entries for 
“Company”, “Position”, “Leaving Reason” and are displayed on the Details page with a down arrow at the right of the 
data input box. 
 
The contents of these drop-down menus may be defined by the user. 
 
To edit the contents of a dropdown menu, select the Configuration form and select the Patient Options tab. Then select 
the ‘Edit’ button. The following message will be displayed: 
 

 
 
It is recommended that a backup copy is made, so select ‘Yes’ and enter a name for the backup file. You can then edit 
the patient details: 
 

 
 
[F1], [F2] & [F3] are user-defined fields that may contain any pertinent notes or observations. 
 
Text inserted under [F4] is displayed within an additional section of the [F3] drop-down menu. 
 
Text inserted under [Print Report Title] will be printed at the top of any audiogram printouts. Only one line of text should 
be inserted. Any existing options may be modified or deleted in the usual way.  
 
Do not delete or modify any of the section headings. 
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When you have finished editing the patient options, press the ‘OK’ button to save your changes.  Alternatively, select 
‘Cancel’ to discard any changes. 
The following will be displayed if you select ‘OK’: 
 

 
 
Select ‘OK’ and then close and re-launch CA850/4A Database for the changes to take effect. 
 

 
 

21.4. THE AUDIOGRAM PAGE 

Select the Audiograms tab as shown below: 
 

 
 
If required, another previously recorded audiogram can be manually entered on the lower line of the two rows of data 
boxes, when the insert audiogram functionality is used. See below for an example: 
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Note that audiometric data may also be transferred from a connected supported audiometer. 
 
If the Audiogram Band option has been selected then hearing performance bands will be displayed on the audiogram 
as shown below. 
 

 
 
Selecting the ‘Colour Key’ button displays the key for the colours used to represent the hearing performance bands in 
the audiograms. 
 



   
 THE MAIN AUDIOLOGY SCREENS 

 
 

 

84   CA850/4A INSTRUCTION FOR USE                                                                                                                   D-0131946-C
  

 

 
 
The performance bands displayed are: 
 

• -10dBHL to +20dBHL: Normal hearing 

• +20dBHL to +40dBHL: Mild hearing loss 

• +40dBHL to +60dBHL: Moderate hearing loss 

• +60dBHL to +90dBHL: Severe hearing loss 

• >90dBHL:  Profound hearing loss 

 
To disable the colour key, press the ‘Colour Key’ button again. 
 
If the Predictive option has been selected then banding indicating typical age-associated hearing loss (AAHL) will be 
displayed on the audiogram as shown below. 
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The AAHL is dependent on age and sex of the patient. The white line through the centre of the grey shaded area is the 
50th percentile. The grey area above this line represents the population between the 50th and the 75th percentile, and 
the grey area below this line represents the population between the 50th and the 25th percentile. 
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Select the Questionnaire tab and then click on the Questionnaire toolbar button.  Complete the presented 
questionnaire (example below) using Yes, No or text to answer the questions, Forward and Back to move through the 
questionnaire and Delete to remove any questions from the questionnaire. Click on Finish to save the results and to exit 
the questionnaire. 
 

 
 

21.5. EDIT (CURRENTLY SELECTED) PATIENT RECORD 

The purpose of this function is to enable the user to manually edit or amend a particular record, e.g. to change the 
patient’s address or job description. 
 

• Select the record by moving the arrowhead on the left side of the register page so that it is adjacent to the required 

record. Alternatively, use Find  to identify the required record. 

• Click on Edit  and amend the appropriate fields. 

• Click on Save  to save the changes. 
 

21.6. DELETE A RECORD 

The purpose of this function is to enable the user to delete a particular patient record or audiogram. 
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21.6.1. DELETING AN AUDIOGRAM 

Select the audiogram to be deleted by selecting the patient record on the Register page using the  arrows 
and then selecting the Audiogram tab. Choose the audiogram you wish to delete using the vertical Sliding Selector at 
the centre of the window. 

• Click on the Delete icon   

• Click Yes to confirm that you wish to delete the record 

Alternatively use Find  to find a particular patient record and then select the audiogram you wish to delete. 

21.6.2. DELETING A COMPLETE PATIENT RECORD 

This is achieved by either: 

• Repeatedly deleting the separate audiograms contained within a patient record. When the final audiogram is 
deleted the complete patient record is also deleted. 

• Selecting Delete a Patient from the Edit menu. This will delete all the audiograms stored for the patient and 
the patient details in a single operation. 

Note: Use the Delete a Patient option with caution. The operation cannot be undone. It is recommended that a back-
up of the database is created first. 
 

21.7. FIND A RECORD 

The purpose of this function is to enable users to view an individual record or group of records based on one-search 
criteria for a particular record parameter. 

• Click on Find  and the dialogue box below will be displayed: 
 

 
 

• Enter the search criteria in upper case text. 

• Click on Find First. If one or more records exist that match the entered search criteria these will be identified on the 
register page. 

• Subsequent records that match the search criteria can be viewed by clicking on Find First. 
 

21.8. SETTING FILTER CRITERIA 

The purpose of this function is to enable users to create user defined reporting groups based on one or more search 
parameters. 
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Click on Filter  and the screen below will be displayed. 

 
 
Enter the required database filter criteria, selecting if necessary any of the data from the current patient selected by 
clicking Current next to the data boxes to include that data in the filter and click Apply Filter. All records that meet the 
criteria will now be listed. To obtain a printout of this list select the Database Summary option from Print. 
 
To set up another filter, click Clear Filter and then enter the new search criteria. 
 
When finished with the filter function, click Clear Filter followed by Close. 
 

21.9. SORTING RECORDS 

The purpose of this function is to enable users to view the presented audiometric records by a number of record 
parameters. 

Click on Sort  and the screen below will be displayed. 
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Select the parameter by which you require the records to be sorted and click OK. The records will now be presented 
according to your selection. 
 

21.10. CREATE AVERAGE FUNCTION 

This function is designed to create an average for a user defined group of patients. When used with the filter function 
to identify a defined group of patients, e.g. by company and test dates etc., successive annual averages can be created 
to monitor overall average hearing levels for that group of individuals over a number of user defined time periods. 
 

21.11. EXIT FROM CA850/4A DATABASE 

When you have completed all required tasks close the CA850/4A Database window in the usual way or click on File and 
then Exit from the main drop-down menu. 
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22. UNINSTALLING THE CA850/4A DATABASE PROGRAM 
This may be carried out in the usual way from Apps and Features in Window Settings. Select CA850/4A Database and 
click on Uninstall. CA850/4A Database and all related programs will be removed from your hard drive. After the uninstall 
operation the database “CA850.mdb” and any exported “.csv” files remain for future use. If required they may be 
deleted separately. 
 
 
  



   
 IMPORTING RECORDS INTO CA850/4A DATABASE 

 
 

 

91   CA850/4A INSTRUCTION FOR USE                                                                                                                   D-0131946-C
  

 

23. IMPORTING RECORDS INTO CA850/4A DATABASE 
This function assumes that a .csv database file with the correct format is available for import. Such a file would typically 
have been previously exported from CA850/4A Database (for example as a backup) or exported from older version 
CA850/4A audiometer (refer to the operating manual for this audiometer). In both cases the default name of the 
exported file is “Exportdata.csv”. 
 
Select File → Import → Import File from the main menu. The dialogue box shown below will appear. 
 

 
 
Navigate to the correct folder, select the required file and click Open. The data will then be imported into CA850/4A 
Database. If a duplicate record is found (based on the Patient Number and the date/time of the test) an error message 
will be displayed: 
 

 
 
The duplicate data will not be imported.  



   
 ERROR MESSAGES 

 
 

 

92   CA850/4A INSTRUCTION FOR USE                                                                                                                   D-0131946-C
  

 

24. ERROR MESSAGES 
Any system errors or problems will normally generate an on-screen error message with an error number. If the problem 
persists please email a copy of the file “err.log” to Amplivox  for advice. This file is located in the CA850/4A Database 
installation directory (e.g. Program Files/CA850-4A Database/err.log if default settings were used for installation). 
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25. CA850/4A DATABASE TROUBLESHOOTING 
In the majority of cases installation of the CA850/4A Database software and device drivers should be a straightforward 
process. However, if you do encounter a problem this section may help to resolve it. 
 

25.1. DEVICE DRIVERS 

It is important to ensure that the latest device drivers are used, especially if a previous Amplivox device driver has been 
installed. This is likely to be the case if the PC has been used previously with an Amplivox audiometer. 
 
If this is the case AND the procedure described in the installation section is not carried out automatically then the 
following should be done 
 
With the audiometer connected and switched on, use Device Manager to display devices listed under “Universal Serial 
Bus controllers”: 
 

 
 
Right click on “Audiological Instrument” and select the “Update Driver ...” option. Refer to the Amplivox Operating 
Manual for USB Driver Installation to update the driver. 
 
If the driver is already the latest version the following window will be displayed:  
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Click on Close to conclude the operation. 
 

25.2. AUDIOMETER NOT CONNECTED 

If CA850/4A Database attempts to communicate with an audiometer when none have been connected the following 
error will be displayed: 
 

 
 
Click on OK to close the error box. Then select the Edit drop-down menu and use the Cancel Insert/Edit option or use 
the Cancel Insert/Edit toolbar button. 
 
Connect the required audiometer and repeat the operation. 
 

25.3. AUDIOMETER IS NOT SWITCHED ON 

If CA850/4A Database tries to communicate with an audiometer that is not switched on the following error will be 
displayed: 
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Click on OK to close the error box. Then select the Edit drop-down menu and use the Cancel Insert/Edit option or use 
the Cancel Insert/Edit toolbar button. 
 
Switch on the audiometer and repeat the operation. 
 

25.4. NO TEST RESULTS 

If no test results are obtained from an audiometer (e.g. after closing the audiometer control program or with other 

communications problem) the following error will be displayed: 

 

 
 

There may be a delay of a few seconds before the above message appears. 

Click on OK to close the error box. Then select the Edit drop-down menu and use the Cancel Insert/Edit option or use 
the Cancel Insert/Edit toolbar button. 
 
Ensure that the audiometer is connected and switched on then repeat the operation. 
 
Note: A similar message (below) will always display if the user exits the audiometer control programme or any other 
communications program without any test results, and these messages should not be confused. 
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